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1 Einleitung 

1 Einleitung 

Die Zahnoberflächen eines Neugeborenen werden früh von Mikroorganismen 

kolonisiert und es bildet sich ein dentaler Biofilm. Dieser nimmt von da an eine 

physiologische Funktion ein, indem er die Besiedelung mit exogenen und potenziell 

pathologischen Mikroorganismen verhindert (Marsh, 1994). 

1.1 Pathogenese von Karies und Parodontitis 

Allerdings kann es zu einer ökologischen Verschiebung im dentalen Biofilm kommen, 

welche Demineralisierungsprozesse und somit Karies fördert, wenn die azidogenen und 

azidurischen Mikroorganismen, wie Streptococcus mutans oder Lactobazillen 

Überhand gewinnen (Kneist et al., 2012; Marsh, 1994; Nyvad & Kilian, 1987). Dieser 

Umstand findet in der ökologischen Plaquehypothese, nach der Karies das Resultat 

dieser ökologischen Verschiebung ist, seinen Ausdruck.

In dem einfachen, aber eindrucksvollen Experiment „Experimental gingivitis in man“ 

konnten Löe et al. 1965 nachweisen, dass die Akkumulation von Plaque und Gingivitis 

einen unmittelbaren Zusammenhang aufweisen. So verzichteten zwölf gesunde, junge 

Menschen für einen Zeitraum von drei Wochen vollständig auf Mundhygiene. Dabei 

zeigte sich neben der Akkumulation des dentalen Biofilms nach zehn bis 21 Tagen eine 

Entzündungsantwort der Gingiva, die klinische Zeichen einer Gingivitis aufwies. Das 

Wiedereinsetzen der Mundhygiene führte wiederum zur Rekonstitution der gingivalen 

Gesundheit (Löe et al., 1965).

Dentaler Biofilm ist somit Grundvoraussetzung und ätiologische Bedingung für die 

Entstehung einer Karies oder Parodontalerkrankung (Löe et al., 1972). Es ist daher zu 

schlussfolgern, dass die Beseitigung des dentalen Biofilms die Mundgesundheit 

verbessern kann.
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1.2 Karies- und Parodontitisprävention 

1.2 Karies- und Parodontitisprävention 

Grundstein für die heutigen Konzepte zur Karies- und Parodontitisprävention ist ein 

von Axelsson et al. entwickeltes Präventionsprogramm, das über drei Jahrzehnte 

evaluiert wurde (Axelsson et al., 2004). Dieses Präventionsprogramm erlangte als 

Karlstad-Studie Bekanntheit. Im Herbst 1971 und Frühjahr 1972 wurden 375 Personen 

in drei Altersklassen von 20 bis 35, 36 bis 50 und 51 bis 61 Jahre in das Programm 

eingeschlossen. Nach einer Eingangsuntersuchung und initialen Zahnsanierung wurden 

die Patienten in den ersten sechs Jahren in ein Recall mit zwei- bis dreimonatigen 

Abstand eingeladen. Diese Recall-Intervalle wurden nach 6 Jahren je nach Risikoprofil 

angepasst und für Patientinnen und Patienten mit geringem oder mittlerem 

Betreuungsbedarf auf einmal bzw. zweimal jährlich verlängert. Nur bei 10% der 

Patientinnen und Patienten wurden vierteljährliche Termine beibehalten. 

Die Intervention bestand in der Veranschaulichung des vorhandenen dentalen Biofilms 

durch Plaquerevelatoren, der Einübung der Bass-Technik und der Empfehlung von 

Zahnseide oder Zahnhölzern. Abschließend erfolgte eine professionelle Zahnreinigung 

mit fluoridhaltiger Prophylaxepaste. Das Programm wurde nach drei, sechs, 15 und 

abschließend 30 Jahren evaluiert. Zu betonen ist, dass der Schwerpunkt dieser 

Intervention bei der Umsetzung einer möglichst guten Mundhygiene und nicht auf der 

regelmäßigen Fluoridanwendung lag.

Der Abschluss der Langzeitbeobachtung hat gezeigt, dass ein gutes Prophylaxekonzept 

die orale Mundgesundheit maßgeblich verbessern kann, so kam es nach 30 Jahren je 

nach Alterskohorte nur zu einem Verlust von 0,4 bis 1,8 Zähnen. Dies entspricht einem 

Verlust von 0,01 bis 0,06 Zähnen pro Jahr. Hauptgrund mit 62% war darüber hinaus 

nicht etwa Karies oder Parodontitis, sondern Zahnfrakturen. Wiesen im Anfangsbefund 

noch 60% aller Zahnflächen dentalen Biofilm auf, reduzierte sich dieser in allen 

Altersgruppen auf weniger 20%, 107 der 257 verbliebenen Patientinnen und Patienten 

wiesen über den gesamten Zeitraum keine neuen kariösen Läsionen auf. 

Bemerkenswert war weiterhin, dass nur wenige Studienteilnehmende aufgrund von 

fehlendem Interesse aus dem Prophylaxeprogramm ausgeschieden waren, was die 

Überzeugungskraft dieser Intervention zeigt (Axelsson et al., 2004).
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1.2 Karies- und Parodontitisprävention 

Eine Kritik an der Karlstad-Studie besteht in den für den klinischen Alltag unrealistisch 

erscheinenden aufwändigen Interventionen in der Anfangszeit. Allerdings hat die 

Studie gezeigt, dass der Erfolg nach einem anfänglich engmaschigen, intensiven und 

konsequenten Prophylaxeprogramm schließlich auch bei größeren Recall-Intervallen 

bestehen blieb. Damit erscheinen die intensiven Bemühungen zu Beginn eine 

nachhaltige und effektive Strategie für den langfristigen Erhalt der Mundgesundheit 

ohne intensive Weiterbetreuung zu sein. 

Der mit dieser Erkenntnis einhergehende Paradigmenwechsel „Vorsorgen statt 

Versorgen“ hat sich in der zahnmedizinischen Versorgung in Deutschland bereits 

vollzogen. Zahnmedizinische Prophylaxe ist neben der kurativen Zahnmedizin heute 

bereits eine Selbstverständlichkeit. Dies bestätigen die Erfolge bisheriger klinischer 

Präventionsmaßnahmen zur Vermeidung von Plaque-assoziierten Erkrankungen wie 

Karies und Parodontitis.

Zwar zeigt die fünfte deutsche Mundgesundheitsstudie (Cholmakow-Bodechtel et al., 

2016) einen Rückgang der Kariesprävalenz in allen Altersgruppen, die Prävalenz bleibt 

dennoch hoch und bestimmte Bevölkerungsgruppen werden nach wie vor anscheinend 

nicht ausreichend oder nicht nachhaltig durch entsprechende Präventionsprogramme 

erreicht.

Ist die Fluoridierung eine sicher bestätigt wirksame Maßnahme in der Prävention 

(Bellini et al., 1981; Marinho et al., 2003; O’Mullane et al., 2016), muss in diesem 

Zusammenhang die Durchführung und Effektivität von Mundhygienemaßnahmen und 

°-instruktionen und deren Nachhaltigkeit diskutiert werden (Ganss et al., 2009, 2018, 

2019; Macgregor & Rugg-Gunn, 1985; Winterfeld et al., 2015).

1.3 Die Präventivzahnmedizinische Sprechstunde

Um die bisher erzielten Erfolge in der zahnmedizinischen Prävention auszubauen, ist es 

ein wichtiger Ansatz, bereits in der zahnmedizinischen Lehre Präventionskonzepte nach 

aktuellem wissenschaftlichem Kenntnisstand zu vermitteln. So ist auch in der Poliklinik 
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1.3 Die Präventivzahnmedizinische Sprechstunde

für Zahnerhaltungskunde und Endodontologie an der Justus-Liebig-Universität in 

Gießen seit Jahrzehnten ein Präventionskonzept im Rahmen der 

Präventivzahnmedizinischen Sprechstunde (PZS) im Studierendenkurs etabliert. Dieses 

ist in die vier Abschnitte Mundhygieneinstruktion, Ernährungsberatung, 

Fluoridierungsmaßnahmen und Remotivation unterteilt und wird unter Supervision 

erfahrener Zahnärztinnen und Zahnärzten von Studierenden des ersten klinischen 

Semesters durchgeführt. Die Patientinnen und Patienten werden über ihren 

Mundhygienezustand und Möglichkeiten der häuslichen Zahnpflege sowie über den 

Zusammenhang von Ernährung, Fluorid, dentalem Biofilm und Karies beraten. Zudem 

erhalten die sie Instruktionen zur Anwendung von Hilfsmitteln zur Mundhygiene. Die 

Patientinnen und Patienten werden durch Anfärben weicher und harter Beläge in Ober- 

und Unterkiefer mit Plaquerevelatoren und Demonstration der angefärbten Bereiche der 

Zahnbögen im Handspiegel motiviert bzw. remotiviert. Der aktuelle 

Mundhygienezustand wird dokumentiert und eine gründliche supragingivale 

Zahnreinigung (professionelle Zahnreinigung /PZR) und Fluoridierung durchgeführt.

Ganss et al. evaluierten 2019 in einer retrospektiven Analyse den Effekt der 

Präventivzahnmedizinische Sprechstunde an der Zahnklinik der Justus-Liebig-

Universität in Gießen nach 15 Jahren. Entgegen den Erwartungen zeigte sich jedoch, 

dass keine wesentliche Verbesserung der Mundhygiene erreicht werden konnte und sich 

die Mundhygiene von Patienten mit anfangs guter Mundhygiene gar verschlechterte 

(Ganss et al., 2019).

In Übereinstimmung mit den unbefriedigenden Resultaten von Ganss et al. 2019 zeigen 

auch andere Studien, dass sich die Implementierung von Mundhygieneinstruktionen 

anscheinend deutlich schwieriger gestaltet als erwartet (Schlueter et al., 2010, 2013).

Andererseits weisen Studien aber auch darauf hin, dass bereits kleine Änderungen in 

der Instruktionsweise schon zur Verbesserung der Anwendung von 

Mundhygienehilfsmitteln führen könnten (Addy et al., 1999; Graetz et al., 2013; Shida 

et al., 2020). Welche Methode der Mundhygieneinstruktion die effektivste ist, ist jedoch 

nicht geklärt (Soldani et al., 2018).
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1.3 Die Präventivzahnmedizinische Sprechstunde

Daher wurde für die Präventivzahnmedizinischen Sprechstunde an der Poliklinik für 

Zahnerhaltungskunde und Endodontologie an der Justus-Liebig-Universität in Gießen 

ein Mundhygieneprogramm mit einem neuen Konzept erarbeitet, welches eine 

veränderte Vorgehensweise der Studierenden sowohl bei Motivation und Remotivation 

von Patientinnen und Patienten als auch bei der Vermittlung von 

Mundhygieneinstruktionen vorsieht.

Die zunehmende Digitalisierung von Praxis und Wissenschaft ermöglicht, die 

berührungslose optische Erfassung der Zahnbögen des Ober- und Unterkiefers nach 

Anfärben des dentalen Biofilms durch einen Intraoralscanner zu verwenden, um ein aus 

diesen Daten entstehendes dreidimensionales Modell der Kiefer der Patientinnen und 

Patienten am Monitor abzubilden (Giese-Kraft et al., 2022; Jung et al., 2022). Nun 

lassen sich anhand dieser 3D-Darstellung des Intraoralscanners die angefärbten 

Bereiche des Zahnbogens eindeutiger darstellen und verdeutlichen als die 

herkömmliche Demonstration an einem Handspiegel. Die 3D-Ansicht erlaubt den 

Studierenden, die gescannten Zahnbögen eindrucksvoll auf dem Bildschirm in alle 

Richtungen zu drehen. Die Patientinnen und Patienten erhalten die Möglichkeit, alle 

Bereiche des Zahnbogens einzusehen und somit eine bessere Vorstellung von den 

Zähnen, die einer gründlicheren Reinigung bedürfen. Zu erhoffen ist dadurch ein 

nachhaltigerer Effekt der Mundhygieneinstruktionen.

Weiterhin vermitteln die Studierenden nunmehr die Mundhygieneinstruktion nicht nur 

verbal oder anhand von Modellen, sondern auch über Videos zur Zahnputzsystematik 

und zur richtigen Anwendung von Zahnseide und mit Zahnputzübungen mit zur 

Verfügung gestellter oder mitgebrachter Zahnbürste und Zahnpasta. Abschließend 

werden Zahnstein und hartnäckige Verfärbungen der Zähne professionell gereinigt und 

eine Schmelzpolitur und Fluoridierung vorgenommen.

Die Studierenden ihrerseits erlernen neben der theoretischen Wissensvermittlung der 

Prophylaxe durch Seminar, Skript und Bereitstellung von Instruktionsvideos 

unmittelbar vor Beginn der Patientinnen- und Patientenbehandlung in den 

Einführungswochen am Anfang des Semesters und erneut zum Abschluss des 

Semesters den Umgang und die effektive Handhabung der Intraoralscanner in 
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1.3 Die Präventivzahnmedizinische Sprechstunde

gegenseitigen Übungen (Anfärben des dentalen Biofilms und Erstellen von 3D-

Intraoralscans der eigenen Zähne).

Das neue Konzept beinhaltet somit eine substanzielle Umstellung, die den Studierenden 

die Reflexion der eigenen Mundhygiene ermöglicht und diese in einem viel größeren 

Maße mit der Selbstwirksamkeit der eigenen Mundhygienekenntnisse konfrontiert.

Durch die mehrfache Anwendung in der Patientinnen- und Patientenbehandlung 

(angefärbter dentaler Biofilm wird auf dem 3D-Intraoralscan den Patienten 

demonstriert, mit den Patientinnen und Patienten werden Putzübungen durchgeführt, 

die Patienten werden instruiert und Instruktionsvideos werden gezeigt) werden die 

Mundhygienekenntnisse vertieft. Die Studierenden wiederum erlernen die individuell 

angepasste Anwendung der Mundhygieneinstruktionen „en passant“ (Reischmann, 

1995).

1.4 Ziel der Studie

Es ergibt sich nun die Frage, in wie weit dieses veränderte aktive Vorgehen die eigene 

Mundhygiene der Studierenden im Laufe des Semesters verändert. Im besten Fall 

könnten die Studierenden selbst von diesem Konzept profitieren und ihre eigene 

Mundhygiene im Laufe des studentischen Kurses verbessern.

Voraussetzung hierfür ist, dass ein inzidentelles Lernen stattfindet. Hierunter versteht 

man beiläufiges Lernen ohne Lernintention und -instruktion. Inzidentell Erlerntes kann 

dabei durchaus Eigenschaften expliziten, also bewussten und zielgerichteten Lernens 

wie Erinnerungsbewusstsein und teilweise verbalisierbare Regelkenntnis beinhalten 

und grenzt sich so vom impliziten Lernen, also Aneignung unbewusster Lernobjekte, 

wie z.B. Fahrradfahren oder aber auch Spracherwerb im Kindesalter, ab (Hoffmann & 

Kintsch, 1996; Röhr-Sendlmeier, 2012).

Im Rahmen dieser Pilotstudie möchten wir also zunächst die Personen in den Fokus 

nehmen, die das neue Mundhygieneprogramm vermitteln, in diesem Fall die 
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1.4 Ziel der Studie

Studierenden, die an dem Präventivzahnmedizinischen Kurs teilnehmen. Hierzu soll 

eine retrospektive Datenanalyse zeigen, ob durch die Teilnahme am praktischen Kurs 

der Präventivzahnmedizinischen Sprechstunde einschließlich der gegenseitigen 

Übungen, der theoretischen Wissensvermittlung im Seminar und letztendlich der 

Vermittlung und Anwendung an Patientinnen und Patienten bei den Studierenden ein 

Lernen bezüglich der von ihnen selbst gegebenen Mundhygieneempfehlungen, also ein 

inzidentelles Lernen erfolgte und ob dadurch Auswirkungen auf die eigene 

Mundhygiene, im optimalen Falle einer Verbesserung, erfolgten.

7



2 Methodik

2 Methodik

Die Studie ist eine retrospektive Auswertung von 3D-Intraoralscans, die im Rahmen 

der gegenseitigen Übungen im Kurs für Zahnerhaltungskunde I entstanden sind.

Es liegt ein positives Votum der Ethik-Kommission der Justus-Liebig-Universität vor 

(AZ 62/22).

Diese gegenseitigen Übungen wurden zu zwei Zeitpunkten durchgeführt:

T0: in den Einführungswochen zu Beginn des Semesters, vor Durchführung des 

Präventionsprogramms an Patientinnen und Patienten

T1: in den abschließenden Übungswochen zum Ende des Semesters, nach 

Durchführung des Präventionsprogramms an Patientinnen und Patienten

Nach Anfärben der Plaque mit dem Plaquerevelator Mira-2-Ton (Hager & Werken 

GmbH & Co KG, Duisburg, Germany) wurden Ober- und Unterkiefer mit dem 

Intraoralscanner CS 3600 der Firma Carestream Dental (Stuttgart, Deutschland) optisch 

erfasst. 

Insgesamt standen je zwei 3D-Intraoralscans von 30 Studierenden zur Verfügung, die 

alle ausgewertet werden konnten. 

Das folgende Schema stellt den Ablauf des Semesters und die Inhalte der 

Präventivzahnmedizinischen Sprechstunde dar:
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2 Methodik

Phase 1: Gegenseitige Übungen mit Anwendung des digitalen 3D-Intraoralscanners in 
den Einführungswochen

Phase 2: Theoretische Vermittlung des neuen Konzeptes des Präventionsprogramms an 
Patientinnen und Patienten im Seminar und Aushändigung eines Skriptes 

 Demonstration des Mundhygienezustandes der Patientinnen und Patienten unter 
Anwendung eines digitalen 3D-Intraoralscanners 

 Dokumentation des aktuellen Mundhygienezustandes (Erhebung von Indizes)

 Motivation und Remotivation

 Ausführliche Beratung und Demonstration von Putztechniken und Hilfsmitteln in 
der häuslichen Zahnpflege

 Zeigen von Instruktionsvideos

 Zahnputzübungen mit den Patientinnen und Patienten

Phase 3: Anwenden des neuen Konzeptes des Präventionsprogramms an Patientinnen 
und Patienten während eines Semesters

Phase 4.  Erneute gegenseitige Übungen mit dem digitalen 3D-Intraoralscanner am Ende 
des praktischen Präventivzahnmedizinischen Kurses 

 Reflektieren über Anwendung / Handhabung Intraoralscanner → interne 
Evaluierung

Schaubild 1: Schematische Darstellung des neuen Konzeptes des Präventivzahnmedizinischen Kurses

2.1 Ablauf der Auswertung

Die retrospektive Erhebung der Daten erfolgte, wie oben ausgeführt, an 3D-

Intraloralscans der Ober- und Unterkiefer zum Zeitpunkt T0 und T1, die im Rahmen 

des Präventivzahnmedizinischen Kurses entstanden waren. Dazu wurde die Menge an 

Plaque für jeden Zahn, außer der Weisheitszähne, vestibulär und oral bestimmt.
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2.1 Ablauf der Auswertung

Für die planimetrische Analyse wurden 2D-Bilder der Vestibulär- und Oralflächen der 

Zähne des 3D-Intraoralscans benötigt. Zu diesem Zweck wurden Screenshots 

angefertigt. 

Um gleiche Aufnahmewinkel der Zahnflächen zur Gewährleistung einer hohen 

intraindividuellen Vergleichbarkeit zu erreichen, wurden die Ober- bzw. Unterkiefer der 

beiden Zeitpunkte in dem 3D-Geometrieverarbeitungsprogramm MeshLab der Version 

v2020.09 (Cignoni et al., 2008) geometrisch ineinander gelagert. So konnten analoge 

Screenshots der entsprechenden Zeitpunkte für die Vestibulär- und Oralflächen jedes 

Zahnes zum Zeitpunkt T0 und T1 angefertigt werden.

MeshLab hat sich bei der Abbildung dreidimensionaler Strukturen im akademisch-

medizinischen Kontext bewährt (Awad et al., 2022; Buschang et al., 2015; Ceylan & 

Emir, 2023).

Ausführliche Pretests hatten gezeigt, dass die Screenshots der 3D-Intraoralscans 

standardisiert werden müssen, da Abweichungen durch Rotation in der x-, y- und z-

Achse, des Zooms oder der Belichtung einen Einfluss auf die planimetrisch bestimmte 

Plaquemenge haben. Um eine hohe interindividuelle Vergleichbarkeit zu erreichen, 

wurden daher Ebenen definiert, die die Aufnahmeeinstellungen zur Anfertigung der 

Screenshots bestimmten, und ein einheitlicher Zoom und Belichtung gewählt.

Die Zahnflächen der Zeitpunkte T0 und T1 wurden synchron ausgeschnitten. Hierzu 

wurde das GNU-Bildbearbeitungsprogramm, nachfolgend GIMP genannt, der Version 

GIMP 2.10.30 (The GIMP Development Team, 2019) genutzt.

Abschließend lagen somit für die vestibulären und oralen Zahnflächen identisch 

ausgeschnittene Bilder zu den beiden Zeitpunkten T0 und T1 vor. Ein planimetrisches 

Auswerteprogramm zählte die mit Plaque assoziierten Farbpixel und errechnete den 

prozentualen Anteil der Pixel, die einem plaquebedeckten Areal zuzurechnen waren, 

anhand der Gesamtzahl der Pixel. 

Im Folgenden wird das Vorgehen im Detail beschrieben.
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2.1.1 Ablauf der Auswertung

2.1.1 Konvertierung des Dateiformats

Die jeweiligen 3D-Intraoralscans lagen nach dem Scanvorgang im proprietären CSZX-

Dateiformat vor. Diese ließen sich ausschließlich über den CS Mesh Viewer öffnen. 

Der CS Mesh Viewer ermöglichte jedoch die Konvertierung in das offene PLY-Format:

Export → Export Format: Export to PLY→ Export

Hierbei ist zu erwähnen, dass die Konvertierung des 3D-Intraoralscans in das PLY-

Dateiformat auch eine PNG-Datei erzeugte. Dabei beinhaltet die PLY-Datei die 

geometrische 3D-Struktur, die in Form von Polygonen beschrieben wird sowie 

hinterlegte assoziierte Datenpfade. Die PNG-Datei enthält die Farbinformation der 

Oberflächenpolygone der dreidimensionalen Struktur, hier des Zahnbogens, und somit 

auch die Plaqueakkumulation auf diesem. Die Farbgestaltung wurde der durch die 

Polygone beschriebenen dreidimensionalen farblosen Struktur übergelegt.

2.1.2 Import in MeshLab

Anschließend wurde die PLY-Datei in das Programm MeshLab importiert:

File→ Import Mesh...→ Auswählen der Datei im .ply-Format

Die mit der PLY-Datei assoziierte PNG-Datei wird dabei automatisch verknüpft, sofern 

sich beide Dateien im gleichen Ordner befinden und deren Namen nicht verändert 

werden.
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2.1.2 Ablauf der Auswertung

Abbildung 1: In MeshLab importierte Oberkiefer desselben Probanden zum Zeitpunkt T0 und T1

Der Import der 3D-Intraloralscans der jeweiligen Zeitpunkte erfolgte gemäß der 

zeitlichen Abfolge der Studie: 

Zunächst wurde der Scan zum Zeitpunkt T0 hochgeladen und bildete somit auch 

„Layer00“. Danach wurde der Scan zum Zeitpunkt T1 ausgewählt, welcher von 

MeshLab somit in zweiter Position als „Layer01“ bezeichnet wurde.

Die beiden importierten Scans des Zahnbogens konnten nun zusammen oder 

unabhängig voneinander in MeshLab betrachtet werden. Das Ein- und Ausblenden ließ 

sich über das Augensymbol in anhängender Projektschaltfläche betätigen:

View→ Show Layer Dialog
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2.1.2 Ablauf der Auswertung

Abbildung 2: Der Layer-Dialog in MeshLab: Über das Augen-Symbol lassen sich die Kiefer einzeln ein- 
und ausblenden.

2.1.3 Matchen der 3D-Intraloralscans

Gemäß einem dem Programm hinterlegten Algorithmus wurden die 3D-Intraloralscans 

in MeshLab importiert und geometrisch ausgerichtet. Die bestmögliche 

intraindividuelle Vergleichbarkeit wird erreicht, wenn die Zahnbögen für die spätere 

Anfertigung der Screenshots in der gleichen räumlichen Position dargestellt sind. Im 

nachfolgenden Anfertigen der Screenshots war die Ausrichtung der 3D-Intraloralscans 

zum Zeitpunkt T0 und T1 dann identisch.

Dazu wurde das das Align-Tool genutzt:

Edit→ Align

Über das Align-Tool können beide Kiefer exakt übereinandergelegt werden. Zunächst 

wurde ein Kiefer als Referenz definiert, an dem sich der andere Kiefer orientierte. In 
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2.1.3 Ablauf der Auswertung

dieser Studie wurde dazu immer der 3D-Intraloralscan zum Zeitpunkt T0 als 

Referenzposition gewählt. Dies geschah über Glue Here Mesh.

Abbildung 3: Das Align-Tool in MeshLab: Der Oberkiefer zum Zeitpunkt T0 war bereits ausgewählt und 
konnte nun über "Glue Here Mesh" fixiert werden.

Danach wurde der 3D-Intraloralscan zum Zeitpunkt T1 angewählt. Per Point Based 

Glueing eröffnete sich eine neue Benutzeroberfläche, in der die 3D-Intraloralscans 

gematcht werden konnten:
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Abbildung 4: Ansicht der Benutzeroberfläche nach Klick auf „Point Based Glueing“: Der Oberkiefer zum 
Zeitpunkt T0 befindet sich auf der linken und der Oberkiefer zum Zeitpunkt T1 auf der rechten Seite. Die 
anatomischen Bezugspunkte wurden bereits definiert (s.u.).

Es wurden mindestens vier markante anatomische Bezugspunkte in numerischer 

Reihenfolge, die auf den Zahnbögen zu den zwei Zeitpunkten gut optisch erfasst 

worden waren, ausgewählt und per Doppelklick definiert. Es konnten beliebig viele 

solcher Bezugspunkte gesetzt werden. Da Weichgewebe verschieblich ist und somit 

größeren Veränderungen zwischen Zeitpunkt T0 und T1 unterliegt, wurden die 

Bezugspunkte in den Zahnhartsubstanzen gesucht.

Nichtsynchrones Zoomen der beiden Scans wurde über das Häkchen Allow Scaling 

erreicht. Anschließend wurde die Auswahl mit OK bestätigt und unter Process wurden 

die Kiefer anschließend mittels Rotationen und Translationen in Deckung gebracht. In 

dem darunter liegenden Logdatei-Textfeld konnten die Abweichungen des 

Matchprozesses abgelesen werden.

Die gematchten 3D-Intraloralscans lagen nun passgenau und in achsengleicher 

Ausrichtung übereinander. Dargestellt wurden diese automatisch in etwas 
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unterschiedlicher Farbe, um sie voneinander diskriminieren zu können. Neben der im 

Textfeld angegebenen Abweichung konnte das Ergebnis also auch optisch kontrolliert 

werden. Die Zahnoberflächen sollten nach dem Matchvorgang möglichst „marmoriert“ 

erscheinen. Je stärker die Marmorierung, desto höher ist die Genauigkeit der 

Überlagerung.

Abbildung 5: Ansicht der gematchten Oberkiefer der Zeitpunkte T0 und T1 in MeshLab mit der typischen 
Marmorierung. Über die Projektschaltfläche (rechts) kann die ursprüngliche Darstellung wieder 
eingestellt werden (hervorgehoben).

Sollte der Algorithmus Ungenauigkeiten aufgewiesen haben, so konnte die Ausrichtung 

des gematchten Kiefers auch manuell über Manual Rough Glueing korrigiert werden.

Die Darstellung mit unterschiedlicher Färbung wurde in der Projektschaltfläche 

View→ Show Layer Dialog → Reiter: Vert → Color: User-Def

wieder in die Originaldarstellung geändert.
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2.1.4 Entfernung von Artefakten

Sollten Artefakte, Weichteilabbildungen oder bestimmte Scanbereiche die Darstellung 

für die spätere Anfertigung der Screenshots beeinträchtigt haben, so konnten diese 

herausgeschnitten werden:

Edit→ Select Faces in a rectagular region

Mit dem Mauszeiger wurden quadratische Flächen gezogen und markiert. Diese 

konnten mit der Taste Strg addiert und mit der Taste Umschalt subtrahiert werden.

Die Taste Alt bewirkt das Auswählen der sichtbaren Meshes im Gegensatz zu dem in 

der Projektschaltfläche angewählten Kiefer.

Durch die Betätigung der Taste Esc kann der Trackball ein- und ausgeblendet und der 

3D-Intraloralscan mit der Maus wieder bewegt werden.

Abbildung 6: Ansicht des Oberkiefers zum Zeitpunkt T1 in MeshLab. Die zu löschende Fläche wurde 
bereits definiert (rot eingezeichnet).

Per 
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2.1.4 Ablauf der Auswertung

Filters→ Selection→ Delete Selected Faces and Vertices

wurden die ausgewählten Bereiche gelöscht. Die ursprüngliche Farbdarstellung gelang 

dann wieder über 

View→ Show Layer Dialog → Reiter: Vert → Texture Coord: On

in der Projektschaltfläche.

2.1.5 Ausrichtung der 3D-Intraloralscans im Weltkoordinatensystem

MeshLab ermöglicht es, die 3D-Intraloralscans in alle drei Richtungen (x-, y- und z-

Achse) dreidimensional im Weltkoordinatensysten auszurichten. Das 

Weltkoordinatensystem lässt sich über 

Render→ Show Axis 

einblenden. Die x-Achse wird rot, die y-Achse wird grün und die z-Achse blau 

dargestellt.
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Abbildung 7: Darstellung der Oberkiefer im Weltkoordinatensystems (farbintensive x-, y-, z-Achsen) in 
MeshLab. Der Trackball ist eingeblendet und erscheint blasser. Der Mittelpunkt des Trackballs 
beschreibt den optischen Bezugspunkt über den sich die Betrachtung der Kiefer mit der linken Maustaste 
und Bewegen der Maus rotieren lässt. Über Halten der Taste Strg und Bewegen der Maus lässt sich der 
optische Bezugspunkt verschieben und über Halten der Taste Umschalt oder über das Mausrad 
vergrößern und verkleinern.

Die Ausrichtung erfolgte über:

Edit→ Manipulators Tool

Nun wurde der eingeblendeten Instruktion gefolgt. Über die Taste T konnte der 3D-

Intraloralscan global verschoben werden.  Die zusätzliche Taste der 

Achsenbezeichnungen X, Y oder Z erlaubte die achsenparallele Verschiebung entlang 

der jeweiligen Achse. Über die Taste R und anschließenden Tastendruck der oben 

genannten Tasten der Achsenbezeichnungen konnte der 3D-Intraloralscan über die 

entsprechenden Achsen rotiert werden. Durch die Betätigung der Taste Esc wurde der 

Trackball ein- und ausgeblendet und eine Bewegung der Ansicht wieder ermöglicht. 

Taste Enter bestätigte die Bewegung, die Rücktaste machte die Bewegung hingegen 

rückgängig. Die veränderte Position wurde über 
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Filters→ Normals Curvatures and Orientation→ Matrix: Freeze current Matrix

für den jeweils angewählten 3D-Intraloralscan als neue 0-Position definiert und über 

File→ Export Mesh as…

bei Bedarf gespeichert.

Nachdem der angewählte 3D-Intraloralscan zum Zeitpunkt T0 ausgerichtet worden 

war, wurde der 3D-Intraloralscan zum Zeitpunkt T1 synchron bewegt. Dies geschah, 

indem über

Filters → Normals, Curvatures and Orientation → Matrix: Set/Copy Transformation

die Achsenverschiebungen ausgelesen

Read from current layer

und der synchron zu verschiebenden 3D-Intraloralscan ausgewählt und die 

Achsenverschiebung ausgeführt wurde:

Apply

Die Fixierung und Speicherung der 0-Position des 3D-Intraloralscans zum Zeitpunkt T1 

erfolgte analog wie oben beschrieben.

2.1.6 Achsendefinition für die jeweiligen Zahngruppen

Zur Ausrichtung der 3D-Intraloralscan bei der Erstellung der Screenshots wurden für 

die x- als auch y-Achse jeweils Punkte definiert. Es entstand eine Ebene, welche durch 

die beiden Achsen zwangsläufig beschrieben wird. Diese Ebene wurde zur Anfertigung 
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2.1.6 Ablauf der Auswertung

der Screenshots parallel zur Blickebene bzw. orthogonal zur Bildschirmebene 

ausgerichtet. So wurde eine Abweichung der Betrachtung in x-Achse und y-Achse 

bestmöglich minimiert. Nur eine Achse, die z-Achse, blieb frei wählbar. Dies war nötig, 

um die ausgeglichene Betrachtung der mesialen und distalen Anteile des jeweiligen 

Zahnes zu erlauben.

Für die unterschiedlichen Zahngruppen wurden für den Ober- sowie Unterkiefer 

unterschiedliche Punkte zur Festlegung der x- und y-Achse definiert, um bei der 

Ausrichtung der 3D-Intralscans den jeweiligen Zahnformen und Zahnachsen Rechnung 

zu tragen und eine weitestgehend senkrechte Betrachtung zu gewährleisten.

So wurden beispielsweise für die Oralflächen der oberen Frontzähne die x- und y- 

Achse so gewählt, dass die typische konkave Form berücksichtigt und eine 

weitestgehend orthogonale Betrachtung ermöglicht wurde. Wäre für alle Vestibulär- 

und Oralflächen die gleiche Ausrichtung gewählt worden, wäre für die Oralflächen der 

oberen Frontzähne ein ungünstiger Betrachtungswinkel zustande gekommen.

Vestibulärflächen der Oberkieferfront- und Seitenzähne

Die y-Achse verlief durch den Kreuzungspunkt zwischen der Tangente der 

Schneidekante des am weitesten in die Okklusionsebene ragenden mittleren 

Schneidezahns und der senkrecht verlaufenden Verbindungslinie durch den 

Kontaktpunkt. 

Die x-Achse verlief im Oberkiefer durch die mesio-palatinalen Höckerspitzen der 

zweiten Molaren.
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Abbildung 8: Ausgerichteter Oberkiefer des Zeitpunktes T0 für die Anfertigung der Screenshots der 
Vestibulärflächen

Oralflächen der Oberkieferseitenzähne

Für Oralflächen der Oberkieferseitenzähne wurde für die y-Achse ein weiter apikal 

liegender Bezugspunkt gewählt: An die apikale Begrenzung des Gingivalsaums auf der 

oralen Seite der mittleren oberen Schneidezähne wurde eine Tangente gelegt. Durch 

den Schnittpunkt dieser mit der Orthogonalen zum Kontaktpunkt verlief die y-Achse.
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Abbildung 9: Anteriorer Bezugspunkt der y-Achse für die Ebene der Oralflächen der Seitenzähne des 
Oberkiefers

Die x-Achse verlief durch die mesio-palatinalen Höckerspitzen der ersten Molaren.
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Abbildung 10: Ausgerichteter Oberkiefer des Zeitpunktes T0 für die Anfertigung der Screenshots der 
Oralflächen der Seitenzähne im Oberkiefer: Anteriorer Bezugspunkt und mesio-palatinale Höcker der 
ersten Molaren.

Oralflächen der Oberkieferfrontzähne

Zur Anfertigung der Screenshots der Oralflächen der OK-Frontzähne verlief die y-

Achse ebenfalls durch die orale, am meisten apikal gelegene Begrenzung des 

Gingivalsaums, die x-Achse jedoch durch die palatinalen Höckerspitzen der ersten 

Prämolaren. Wenn diese z.B. wegen kieferorthopädischer Ausgleichsextraktionen 

fehlten, verlief die x-Achse durch die palatinalen Höckerspitzen der zweiten 

Prämolaren.
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Abbildung 11: Ausgerichteter Oberkiefer des Zeitpunktes T0 für die Anfertigung der Screenshots der 
Oralflächen der Frontzähne im Oberkiefer: Anteriorer Bezugspunkt und palatinale Höcker der ersten 
Prämolaren

Vestibulärflächen der Unterkieferzähne und Oralflächen der Unterkieferfrontzähne

Im Unterkiefer wurde für alle Vestibulärflächen der Front- und Seitenzähne als auch die 

Oralflächen der Seitenzähne die gleiche Einstellung gewählt. Die y-Achse verlief durch 

den Inzisalpunkt und die x-Achse durch die disto-bukkalen Höckerspitzen der zweiten 

bleibenden Molaren. Dies entspricht der Okklusionsebene.
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Abbildung 12: Ausgerichteter Unterkiefer des Zeitpunktes T0 für die Anfertigung der Screenshots der 
Vestibulärflächen und Oralflächen der Seitenzähner: Inzisalpunkt und disto-bukkaler Höcker der zweiten 
Molaren

Oralflächen der Unterkieferfrontzähne

Um eine gute Darstellung der Plaque der Oralflächen der Unterkieferfrontzähne zu 

erreichen, verlief die y-Achse durch den Kreuzungspunkt der Tangente der apikalen 

Begrenzung des lingualen Gingivalrandes der mittleren Schneidezähne und der 

orthogonal verlaufenden Verbindungslinie durch den Inzisalpunkt. Die x-Achse verlief 

durch die bukkalen Höckerspitzen der zweiten Prämolaren.
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Abbildung 13: Ausgerichteter Unterkiefer des Zeitpunktes T0 für die Anfertigung der Screenshots der 
Oralflächen der Unterkieferfrontzähne im Unterkiefer:Anteriorer Bezugspunkt und bukkale Höcker der 
zweiten Prämolaren

2.1.7 Anfertigen der Screenshots

Als Ansichtsprojektionsmodus wurde die orthogonale Projektion gewählt. Dies 

ermöglichte uns die größengleiche Betrachtung ohne blickgeometrische Verzerrungen:

View→ Toggle Orthographic Camera.

Zur Anfertigung der Screenshots wurden die x- und y-Achse nun auf in eine Blickebene 

gebracht. Über die z-Achse konnte frei rotiert werden, bis die bestmögliche Darstellung 

der Zahnhartsubstanzen des betreffenden Zahnes erreicht war. Sie stellte somit die 

einzig frei wählbare Variable bei der Anfertigung der Screenshots dar.

Sie wurde so gewählt, dass bei Betrachtung der Vestibulär- oder Oralflächen der 

jeweiligen Zahngruppen die mesialen und distalen Approximalbereiche bestmöglich 

dargestellt wurden.
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Abbildung 14: Betrachtung des Zahnes 26 zum Zeitpunkt T0 und T1 in MeshLab: Die x- und y-Achse 
bilden eine Ebene, welche orthogonal zur Bildschirmebene verläuft. Die freie Rotation über die z-Achse 
ist mit einem blauen Pfeil illustriert. Der Zoom ist zur Veranschaulichung noch nicht eingestellt (siehe 
unten).

Pretests hatten außerdem gezeigt, dass Schattierungs- bzw. Belichtungseinstellungen 

Einfluss auf die Interpretation der Plaqueflächen des planimetrischen 

Auswerteprogramms haben. So wirkten sich Schattierungen des Modells verfälschend 

im Sinne falsch-positiver Ergebnisse aus. Jedoch erleichterten Schattierungen die 

Diskrimination pink-rosa angefärbter Plaque-behafteten Zahnhartsubstanzen gegenüber 

der blass-rosa Gingiva, da die komplexe dreidimensionale Struktur des Gingivalsaums 

Schatten warf.

Es wurden die Vorteile beider Schattierungs- bzw. Belichtungseinstellungen 

kombiniert, indem die Screenshots in der gewählten Position der 3D-Intraloralscans 

sowohl mit der als Face beschriebenen, konstanten Schattierung

View→ Show Layer Dialog → Reiter: Vert → Shading: Face

als auch in der ausgeschalteten Schattierung None 
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View→ Show Layer Dialog → Reiter: Vert → Shading: None

angefertigt wurden. Bei der Schattierung wurde koaxiales Licht gewählt. Dies ist bei 

MeshLab voreingestellt, konnte bei Bedarf aber über Tastendruck Strg und Umschalt 

und Bewegung der Maus verändert werden. Wichtig war, die Betrachtungsansicht 

zwischen dem Anfertigen der beiden Belichtungseinstellung nicht zu ändern.

Der Zoom wurde formatfüllend auf einem Dell U2412M (16:10, 1920x1200) der Firma 

Dell Technologies (Texas, USA) eingestellt.

Abbildung 15: Zahn 26 von vestibulär zum Zeitpunkt T0 und T1 in MeshLab: Bereit zur Anfertigung von 
Screenshots in der Belichtungseinstellung „Face“. Die x- und y-Achse liegen übereinander, die mesialen 
und distalen Bereiche sind gleichmäßig und der Zoom formatfüllend eingestellt.
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Abbildung 16: Die gleiche Betrachtung des Zahnes 26 von vestibulär in MeshLab wie in Abb. 15, jedoch 
in der Belichtungseinstellung „None“.

Über

File→ Save Snapshot

öffnete sich ein Dialogfenster. Nun konnte die jeweilige Belichtungseinstellung 

abgespeichert werden. Hierzu wurde neben dem Speicherpfad der Screenshot benannt. 

Der Haken bei Snap All Layers musste gesetzt werden, damit die 3D-Intraloralscans 

zum Zeitpunkt T0 und T1 synchron abgespeichert wurden. Als Hintergrund wurde 

Solid Black gewählt.
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Abbildung 17: Abspeicherung des Screenshots in der Belichtungseinstellung „Face“. Auswählen des 
Pfades, Benennung des Screenshots und „Snap All Layers“ ist ausgewählt.

Abbildung 18: Abspeicherung des Screenshots in der Belichtungseinstellung „None“. Auswählen des 
Pfades, Benennung des Screenshots und „Snap All Layers“ ist ausgewählt.
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Es entstanden also pro Zahn vestibulär und oral je vier Screenshots in der gleichen 

Ausrichtung bzw. Perspektive:

– Screenshot zum Zeitpunkt T0 in konstanter Schattierung

– Screenshot zum Zeitpunkt T1 in konstanter Schattierung

– Screenshot zum Zeitpunkt T0 ohne Schattierung

– Screenshot zum Zeitpunkt T1 ohne Schattierung

2.1.8 Ausschneiden der Zahnflächen

Die Screenshots wurden in das Programm GIMP importiert und auf dem Cintiq 16 

Tablet (16:9, 1920x1080) der Firma Wacom (Kazo, Japan) dargestellt:

File→ Open as Layers…

Die Screenshots lagen nun in vier Ebenen übereinander. Die beiden Ebenen mit der 

Belichtungseinstellung Face lagen zuoberst. Der Vordergründige davon entsprach dem 

Zeitpunkt T0 und wurde mit ca. 50%iger Transparenz gezeigt. Die Screenshots mit der 

Belichtungseinstellung Face zum Zeitpunkt T0 und T1 konnten nun durch die 

Transparenz des vordergründigsten Scans gleichermaßen betrachtet werden. Etwaige 

Diskontinuitäten, welche im Alignment oder dem Scanprozess begründet waren, 

konnten nun erkannt werden. Insbesondere den Approximalflächen und dem 

Gingivalsaum wurde besondere Beachtung geschenkt. War eine Verschiebung des 

Screenshots des Zeitpunktes T0 nötig, um die Screenshots der Zeitpunkte T0 und T1 

kongruent darzustellen, wurde dieser verschoben. Hierzu wurde der Screenshots der 

Belichtungseinstellung Face des Zeitpunktes T0 mit der Belichtungseinstellung None 

des Zeitpunktes T0 zunächst verknüpft. Dazu wurde im Layer-Dialog neben das 

Augensymbol der entsprechenden Layer geklickt. Die Verknüpfung wurde mit einem 

Schloss-Symbol angezeigt. Anschließend konnten beide Ebenen kongruent verschoben 

werden:
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Tools→ Transform Tools→ Move

Abbildung 19: Ansicht des Bildfensters mit Zahn 26 von vestibulär und des Layer-Dialogs in GIMP. Im 
Layer-Dialog sind die vier Screenshots als Ebenen zu sehen. Die 50%-ige Transparenz ist bereits 
eingestellt und die Layer des Zeitpunktes T0 in „Face“ und „None“ sind verknüpft (blaue Pfeile).

Mit Hilfe der Freien Auswahl bzw. des Lassowerkzeuges 

Tools→ Selection Tools→ Free Select

wurden die Vestibulär- bzw. Oralflächen getract bzw. ausgeschnitten. Es wurden dabei 

die beiden Screenshots T0 weiterhin mit 50%iger Transparenz und T1 vollständig opak 

in der Belichtungseinstellung Face betrachtet. Der Schnitt ging dabei durch alle 

übereinandergelegten Screenshots bzw. Ebenen.
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Abbildung 20: Ansicht des Bildfensters mit Zahn 26 von vestibulär und des Layer-Dialogs in GIMP. Mit 
Hilfe des Lasso-Werkzeugs wurde der Zahn bereits in allen vier Ebenen synchron ausgeschnitten 
(schwarz-weiße Linie).

Anschließend wurden jeweils die herausgeschnittenen Bereiche der Ebenen der 

Belichtungseinstellung None zum Zeitpunkt T0 und T1 ausgewählt, kopiert

Rechtsklick→ Edit→ Copy

und diese auf jeweils neue Bilder mit schwarzem Hintergrund gelegt:

File→ New...→ Ok und Tools→ Paint Tools→ 

Bucket Fill (schwarze Farbe auswählen)

Nach dem anschließenden Export im JPG-Format

File→ Export As…

lagen die Bilder zur planimetrischen Auswertung bereit vor.
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Abbildung 21: Mit GIMP ausgeschnittenes und mit schwarzem Hintergrund versehenes Bild des Zahnes 
26 von vestibulär zum Zeitpunkt T0

Abbildung 22: Mit GIMP ausgeschnittenes und mit schwarzem Hintergrund versehenes Bild des Zahnes 
26 von vestibulär zum Zeitpunkt T1
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2.1.9 Planimetrische Auswertung

Ein mit den Paketen ImageMagick und Images, sowie der Programmiersprache Julia 

(Version 1.6.28) 2022 von Jung et al. entwickeltes Programm wurde für die 

Quantifizierung der Plaque genutzt (Jung et al., 2022). Das Programm wandelte das 

JPG-Bild in ein RGB-Bild um. Die Farbwerte Rot, Grün und Blau jedes Pixels wurden 

ermittelt, in ein 3-Komponenten-Vektorsystem transformiert und separat gespeichert. 

Zur Berechnung der Plaquebedeckung wurden zwei Filter verwendet. Zunächst 

entfernte ein Filter alle Pixel des schwarzen Hintergrunds (RGB= 0, 0, 0). Ein weiterer 

Filter diente der Quantifizierung der Plaquebedeckung und machte sich die individuelle 

Zusammensetzung der Farbkomponenten (RGB-Farbwert) jedes Pixels zu Nutze. Die 

Schwellenwerte für Grün und Blau wurden auf 0 gesetzt. Da jedes farbige Pixel Anteile 

von Rot aufweist, wurde ein Schwellenwert für den roten Anteil definiert, welcher die 

Plaque beschrieb. Das Programm ermöglichte, die Auswirkung der Änderung des 

Schwellenwerts am Bildschirm optisch zu verfolgen. Nach Definition des 

Schwellenwerts wurde ein neues JPG-Bild erzeugt, welches die nicht von Plaque 

bedeckten Bereiche blau illustrierte.

Abbildung 23: Mit ImageMagick ausgewertetes Bild des Zahnes 26 von vestibulär zum Zeitpunkt T0 
(degree of coverage [%]: 8,91)
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Abbildung 24: Mit ImageMagick ausgewertetes Bild des Zahnes 26 von vestibulär zum Zeitpunkt T1 
(degree of coverage [%]: 5,19)

Die Auswertung der Vestibulär- und Oralflächen aller Zähne erfolgte in einer 

Stapelauswertung. Wo nötig wurde der Schwellenwert geringfügig verändert, um 

Varianzen Rechnung zu tragen, welche beispielsweise in unterschiedlichen 

Lichtbedingungen oder Intensität der Anfärbung begründet waren. Der prozentuale 

Anteil der plaquebedeckten Flächen (P%) wurde aus dem Verhältnis aller Pixel zu den 

Pixeln berechnet, die unter den individuell festgelegten Schwellenwerten lagen.
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3 Statistik

Die statistische Analyse erfolgte mit IBM SPSS Statistics (Version 27: IBM 

Deutschland GmbH, Böblingen, Deutschland).

Die Daten (Plaquewerte nach Probandin/Proband) wurden zunächst in Bezug auf ihre 

Verteilung getestet. Da sich weder für T0 noch für T1 signifikanten Abweichungen von 

der Gauß-Verteilung zeigten (Kolmogorov-Smirnov-Test), wurden generell 

parametrische Testverfahren verwendet und die Plaquewerte werden als arithmetischer 

Mittelwert mit Standardabweichung angegeben.

Inwieweit sich die Plaquewerte von T0 zu T1 verändern, wurde mit t-Tests für gepaarte 

Stichproben untersucht. Inwieweit sich Zahngruppen oder Zahnflächen voneinander 

unterscheiden, wurde mit t-Tests für unabhängige Stichproben analysiert. Inwieweit 

Plaquewerte zu T0 und T1 miteinander assoziiert sind, wurde mit der Pearson 

Korrelation betrachtet. 

Das Signifikanzniveau wurde bei 0,05 festgelegt, bei multiplen Vergleichen 

(Betrachtung nach Zahngruppen und nach Zahn) wurde eine Bonferroni-Adjustierung 

vorgenommen.

Zur Bestimmung der Reliabilität der Messungen wurde ein Proband nach Zufall 

gezogen und die Intraoralscans zu T0 und T1 ein zweites Mal ausgewertet. Dies 

umfasste alle Verarbeitungsschritte, nämlich Matchen, Ausrichten, Screenshots, 

Ausschneiden der Zahnflächen sowie automatisierte planimetrische Auswertung, und 

resultierte in je 56 Messwerten für die Plaquebedeckung mit einer Spannweite zwischen 

0,45 % und 26,2 %. 

Für T0 betrug der Median [95%CI] für die Gesamtplaquebedeckung für die erste 

Auswertung 5,8 % [3,7;7,1] und für die zweite Auswertung 5,9 % [3,7;7,1) (p = 0,446) 

und für T1 5,4 % [3,5;7,6] und 6,1 % [4,1;7,5] (p = 0,304). Die mediane Differenz 

[95%CI] von erster und zweiter Auswertung betrug 0,002 [-0,05;0,08] für T0 und -0,05 

[-0,13;0,03] für T1. 

Der Intraklassenkoeffizient (Modell: zweifach gemischt, Typ: absolute 

Übereinstimmung; 95%CI) betrug 0,999 [0,998;0,999) für T0 und 0,994 [0,989; 0,996] 
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für T1 (p jeweils < 0,001). Das Streudiagramm für alle Messwerte (Abbildung 25) zeigt 

eine sehr gute Übereinstimmung der Werte in allen Messwertdimensionen. 

Abbildung 25: Streudiagramm für alle Messwerte für die 
Plaquebedeckung (n = 112), die Linie repräsentiert y = x

39



4 Ergebnisse

4 Ergebnisse

4.1 Betrachtung der Gesamtplaquewerte

Die Probandinnen und Probanden zeigten ein breites Spektrum von Plaquewerten, 

welches von 6,5 % bis 25,4 % zu T0 und von 5,2 % bis 19,4 % zu T1 reichte 

(Abbildung 26).

Insgesamt verringerte sich der Plaquewert von 14,5 ± 4,4 % zu T0 auf 13,1 ± 3,7 % zu 

T1 (p 0,025).

Abbildung 26: Verteilung der Plaquewerte zu T0 und T1, die horizontalen Linien zeigen den 
arithmetischen Mittelwert.

Die Reduktion der Plaquebedeckung zeigte sich nur bei Personen mit dem höchsten 

Terzil an Werten. Diese verringerten sich von 19,1 ± 3,1 % zu T0 auf 15,1 ± 2,7 % zu 

T1 (n = 9; p < 0,001). Bei Personen mit Plaquewerten im mittleren (n = 10; T0: 14,2 ± 

0,8 %; T1: 14,6 ± 2,2 %; p = 0,559) und unteren (n = 10; T0: 9,7 ± 2,4 %; T1: 9,2 ± 3,1 

%; p = 0,631) Terzil zeigten sich dagegen keine signifikanten Veränderungen.
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4.1 Betrachtung der Gesamtplaquewerte

Insgesamt zeigte sich eine deutliche Korrelation der Plaquewerte zu T0 und T1 (r = 

0,714; p < 0,001; Abbildung 27)

Abbildung 27: Korrelation der Plaquewerte (%) zu T0 und T1; gestrichelte Linie: y = x.

4.2 Betrachtung der Plaquewerte nach Kiefer, Zahn und 
Fläche

Im Oberkiefer lagen die Plaquewerte im Bereich der Vestibulärflächen zu T0 bei 12,8 ± 

9,1 % und im Bereich der Oralflächen bei 12,3 ± 13,7 % (p = 0,559) und zu T1 bei 11,3 

± 8,2 % bzw. 10,6 ± 11,2 % (p = 0,358). Der Unterschied der Plaquewerte in beiden 

Bereichen zu T1 im Vergleich zu T0 erreichte Signifikanz (je < 0,001). 

Die Verteilung der Plaquewerte nach Zahntyp (Tabelle 1) unterschied sich jedoch 

deutlich. Vestibulär fand sich bei Molaren deutlich mehr Plaque als bei Prämolaren und 

schließlich bei Frontzähnen. Oral lag der Plaquewert zu T0 bei den Molaren höher als 

bei Prämolaren und Frontzähnen, deren Plaquebedeckung sich nicht unterschied. Zu T1 

zeigte sich für Molaren und Prämolaren eine ähnliche Plaquebedeckung, ebenso wie für 

Prämolaren und Frontzähne. Abbildung 28 stellt die Plaquewerte nach Zahn dar. 
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Während im Bereich der Vestibulärflächen die zweiten Molaren die höchsten 

Plaquewerte zeigten, welche nach anterior kontinuierlich abnahmen, fand sich bei den 

Oralflächen eine relativ gleichmäßige Plaquebedeckung. Dieses Verteilungsmuster fand 

sich sowohl zu T0 als auch zu T1.

Im Unterkiefer lagen die Plaquewerte im Bereich der Vestibulärflächen zu T0 bei 11,6 

± 11,6 % und im Bereich der Oralflächen bei 17,6 ± 12,6 % (p < 0,001) und zu T1 bei 

10,2 ± 10,1 % bzw. 15,9 ± 12,4 % (p < 0,001). Der Unterschied der Plaquewerte in 

beiden Bereichen zu T1 im Vergleich zu T0 erreichte wie im Oberkiefer jeweils 

Signifikanz (je < 0,001).

Ähnlich wie im Oberkiefer unterschied sich die Verteilung nach Zahntyp ebenfalls 

(Tabelle 1). Im Bereich der Vestibulärflächen zeigte sich jeweils eine signifikante 

Abnahme der Plaquewerte von den Molaren zu den Prämolaren und zu den 

Frontzähnen. Im Bereich der Oralflächen unterschieden sich die Plaquewerte der 

Molaren und Prämolaren nicht signifikant, die Plaquebedeckung der Frontzähne war 

jedoch geringer als bei den beiden anderen Zahngruppen. Dieses Verteilungsmuster 

fand sich zu T0 und zu T1.

Die Betrachtung der Plaquewerte nach Zahn (Abbildung 28) zeigt für die 

Vestibulärflächen ähnlich wie im Oberkiefer die höchsten Plaquewerte im posterioren 

Bereich, welche nach anterior abnahmen. Dieses Muster war jedoch deutlich geringer 

ausgeprägt als im Oberkiefer. Die höchsten Plaquewerte zeigte der Zahn 47. Im Bereich 

der Oralflächen fanden sich durchgängig hohe Plaquewerte in verhältnismäßig 

gleichmäßiger Verteilung mit Ausnahme der Zähne 33 und 32, die deutlich geringere 

Plaquewerte aufwiesen, als die anderen Zähne. Dieses Verteilungsmuster stellte sich zu 

T0 und T1 gleichermaßen dar.
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4.2 Betrachtung der Plaquewerte nach Kiefer, Zahn und Fläche

Tabelle 1: Plaquebedeckung (%; arithmetischer Mittelwert ± SD) nach Zahngruppe für die Vestibulär- 
und Oralflächen des Ober- und Unterkiefers. Gleiche Buchstaben bedeuten keine signifikanten 
Unterschiede zwischen den Zahngruppen (Signifikanzniveau nach Bonferroni-Adjustierung < 0,002)

T0 vestibulär T0 oral T1 vestibulär T1 oral

Oberkiefer

Molaren 23,1 ±17,6 a 16,8 ± 9,0 a 19,3 ± 13,9 a 14,1 ± 7,4 a

Prämolaren 10,4 ± 8,8 b 13,0 ± 8,0 b 10,2 ±8,2 b 11,4 ± 7,0 ab

Frontzähne 6,4 ± 8,0 c 10,0 ± 8,8 b 5,2 ± 6,4 c 9,3 ±8,9 b

Unterkiefer

Molaren 15,5 ± 10,8 a 23,8 ± 10,7 a 14,1 ± 11,2 a 22,7 ± 12,5 a

Prämolaren 10,8 ±7,3 b 26,9 ±13,0 a 9,7 ± 7,8 b 23,6 ±13,7 a

Frontzähne 7,8 ± 7,3 c 18,4 ± 15,2 c 6,8 ± 6,2 c 17,1 ± 14,4 c

Abbildung 28: Darstellung der Plaquewerte nach Zahn (arithmetischer Mittelwert ± SD) zu T0 und T1

43



4.2 Betrachtung der Plaquewerte nach Kiefer, Zahn und Fläche

Tabelle 2 stellt die Dimension der Veränderung der Plaquebedeckung für jeden Zahn 

und nach Fläche dar. Dabei fanden sich für Zähne des Ober-, als auch des Unterkiefers 

nur sehr geringe Änderungen der Plaquebedeckung, welche keine Signifikanz 

erreichten. Eine Ausnahme bildet die Oralfläche des Zahne 45. 

Weiterhin zeigte sich für die Oralflächen bei 6 der 14 Oberkieferzähne und bei 9 der 14 

Unterkieferzähne eine signifikante Korrelation der Plaquewerte von T0 zu T1, dies 

waren jeweils zumeist die Frontzähne. Für die Vestibulärflächen fanden sich 

signifikante Korrelationen für 9 der 14 Oberkieferzähne und für 7 der 14 

Unterkieferzähne.

Tabelle 2: Differenzen der Plaquebedeckung T0 - T1 (arrithmetischer Mittelwert ± SD) sowie 
Korrelationen (Korrelationskoeffizient r) der Plaquebedeckung zu T0 und T1 für jeden Zahn nach Fläche. 
Signifikanzwert 1 bezieht sich auf den Vergleich der Plaquewerte zu T0 und T1, Signifikanzwert 2 bezieht 
sich auf die Korrelation der Plaquewerte zu T0 und T1. Signifikanzniveau nach Bonferroni-Adjustierung 
= 0,001 (fett hervorgehoben: signifikante Werte; dunkelgrau: Molaren, mittelgrau: Prämolaren, hellgrau: 
Frontzähne) 

Zahn Plaquewert (%) Signifikanzwert 1 Korrelation (r) Signifikanzwert 2

oral vestibulär oral vestibulär oral vestibulär oral vestibulär

Oberkiefer

17 3,0 ± 10,6 4,9 ± 15,2 0,133 0,091 0,376 0,634 0,041 < 0.001

16 1,5 ± 7,9 1,9 ± 9,1 0,361 0,216 0,320 0,521 0,085 0,003

15 2,6 ± 7,5 0,0 ±7,1 0,067 0,999 0,597 0,580 < 0.001 < 0.001

14 -0,5 ± 7,5 0,9 ± 5,4 0,745 0,383 0,375 0,552 0,049 0,002

13 1,1 ± 5,4 0,8 ± 5,3 0,272 0,388 0,431 0,374 0,017 0,042

12 2,1 ± 8,7 2,7 ± 7,3 0,206 0,053 0,643 0,501 < 0.001 0,005

11 2,0 ± 7,4 1,4 ± 7,3 0,144 0,285 0,648 0,745 < 0.001 < 0.001

21 -1,6 ± 10,1 0,3 ± 5,4 0,382 0,761 0,563 0,771 0,001 < 0.001

22 1,0 ± 10,5 2,4 ± 5,8 0,610 0,028 0,520 0,554 0,003 0,001

23 -0,4 ± 4,9 -0,4 ± 8,5 0,652 0,774 0,772 0,613 < 0.001 < 0.001

24 3,2 ± 7,8 0,0 ± 8,0 0,037 0,987 0,439 0,716 0,019 < 0.001

25 1,1 ±5,4 -0,1 ± 5,8 0,281 0,942 0,725 0,793 < 0.001 < 0.001

26 2,3 ± 7,1 2,6 ± 12,1 0,085 0,254 0,427 0,634 0,019 < 0.001

27 3,9 ± 9,9 5,9 ± 14,9 0,037 0,040 0,544 0,688 0,002 < 0.001

Unterkiefer

37 -1,7 ± 15,6 -0,6 ± 8,9 0,560 0,711 0,161 0,477 0,404 0,009

36 1,1 ± 10,9 1,3 ± 6,6 0,576 0,268 0,592 0,631 < 0.001 < 0.001

35 -0,4 ±15,4 1,2 ± 6,7 0,885 0,339 0,356 0,626 0,054 < 0.001
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34 1,5 ±14,0 0,3 ± 6,8 0,572 0,847 0,516 0,533 0,005 0,004

33 1,1 ± 8,0 0,6 ± 5,7 0,438 0,541 0,844 0,514 < 0.001 0,004

32 2,6 ± 6,9 0,1 ± 5,4 0,052 0,919 0,844 0,503 < 0.001 0,005

31 1,2 ± 12,9 1,5 ± 7,0 0,627 0,261 0,590 0,370 < 0.001 0,044

41 1,9 ± 10,5 2,1 ± 9,3 0,338 0,218 0,658 0,571 < 0.001 < 0.001

42 -0,6 ± 10,6 1,5 ± 6,0 0,764 0,914 0,830 0,639 < 0.001 < 0.001

43 3,4 ± 14,4 0,4 ± 4,5 0,203 0,635 0,623 0,678 < 0.001 < 0.001

44 3,5 ± 13,8 1,5 ± 5,6 0,192 0,155 0,473 0,744 0,011 < 0.001

45 8,3 ± 12,4 1,2 ± 5,6 < 0,001 0,254 0,507 0,751 0,004 < 0.001

46 2,8 ± 9,3 1,7 ± 6,2 0,122 0,155 0,601 0,768 < 0.001 < 0.001

47 2,0 ± 11,0 3,0 ± 13,3 0,318 0,219 0,595 0,601 < 0.001 < 0.001
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5 Diskussion

5.1 Quantitative Erhebung des dentalen Biofilms

5.1.1 Etablierte klinische Plaqueindizes

Nachdem der ursächliche Zusammenhang zwischen dentalem Biofilm einerseits sowie 

Karies und Parodontalerkrankungen andererseits erkannt wurde, suchte man Methoden, 

um Plaquemengen auf Zahnoberflächen zu erfassen und quantitativ zu messen. Daher 

wurden früh verschiedene klinische Indizes entwickelt, die neben der Anwendung in 

der zahnärztlichen Praxis im epidemiologischen und wissenschaftlichen Kontext 

verwendet werden konnten (Ramfjord, 1959). Dabei erfolgte die visuelle Inspektion 

nach Anfärbung der Plaque durch Plaquerevelatoren. Der Index stellt hier einen 

numerischen Wert dar, welcher vorher durch eine diagnostische Einteilung definiert 

wurde. 

Nach dem von Ramfjord 1959 entwickelten Index hat sich der Plaqueindex nach 

Quigley-Hein aus dem Jahre 1962 unter anderen als klinischer Index etabliert, wobei 

heute zumeist die Modifikation nach Turesky verwendet wird (Turesky et al., 1970). 

Dabei werden alle Zähne außer den Weisheitszähnen nach Anfärben der Plaque von 

bukkal und oral in einem sechsstufigen Indexsystem eingeordnet. Grad 0 liegt bei 

Abwesenheit von Plaque vor, Grad 1 beschreibt einzelne Plaquekolonien entlang des 

Gingivalsaums, Grad 2 eine dünne kontinuierliche Plaquelinie am Gingivalsaum, die 

weniger als 1 mm beträgt, Grad 3 gingivanahe Zahnbeläge breiter als 1 mm aber 

weniger als ⅓ der Zahnoberfläche, Grad 4 Zahnbeläge zwischen 1/3 und 2/3 der 

Zahnoberfläche, Grad 5 schließlich mehr als 2/3 der Zahnoberfläche. Auch wenn der 

Plaqueindex nach Quigley-Hein modifiziert nach Turesky klinisch erprobt und als 

Index zu Beurteilung der Oralhygiene weitläufig akzeptiert ist, finden sich Nachteile. 

Zwar werden subtile Plaquemengen im gingivanahen Zahndrittel erfasst, aber klinisch 

relevanten Bereichen wie zum Beispiel dem Approximalraum ungenügende Beachtung 

geschenkt.
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Ein weiterer häufig verwendeter Plaqueindex ist der Navy-Plaque-Index modifiziert 

nach Rustogi et al. (Rustogi et al., 1992). Er ist kleinteiliger und legt neben den 

gingivalsaumnahen Bereichen einen Fokus auf die Approximalbereiche. Er teilt alle 

Zähne bukkal und oral in neun ungleich große Felder ein. Dabei sind drei Felder (A-C) 

gingivanah, weitere drei (D-F) sind koronal zu diesen gelegen, zwei Felder (G und H) 

sind jeweils für den mesialen bzw. distalen Approximalbereich und ein weiteres Feld (I) 

ist für den Koronalbereich vorgesehen. Jeder Bereich erhält im Sinne einer dichotomen 

Einordnung nach Anfärben bei Abwesenheit von Plaque die Kategorie 0 und bei 

Anwesenheit von Plaque die Kategorie 1. Die Summe aller plaquebehafteter Felder 

durch die Anzahl der bewerteten Felder ergibt den Indexwert. Dabei stellt die 

gedankliche Einteilung der Zahnflächen, die je nach Zahntyp und -fläche 

unterschiedlich groß und proportioniert sind, in diese neun Felder jedoch eine 

Herausforderung dar. Weiterhin ist bei diesem Index auch bei insgesamt geringer 

Plaquebedeckung schnell der Maximalwert erreicht, was dessen Trennschärfe reduziert.

Gemeinsam ist den genannten klinischen Indizes die Subjektivität der Bewertung, der 

hohe Arbeitsaufwand für Erhebung und inter- und intraindividuelle Kalibrierung. 

Aufgrund der Dichotomie werden Änderungen der Plaquebedeckung nur ungenügend 

dargestellt. So ist es möglich, dass Plaque in bestimmten Bereichen z.B. um 50% 

abnimmt, jedoch weiterhin der gleiche Indexwert besteht. Es sind Indizes mit ordinaler 

Skalierung (Pretty et al., 2005; Rikvold et al., 2023).

5.1.2 Planimetrische Verfahren

Planimetrische Verfahren beruhen auf der Ermittlung der Plaquebedeckung (ohne 

dessen räumlichen Einteilung) im Verhältnis zu der gesamten Zahnoberfläche. Die 

Plaquebedeckung wird so in einer Verhältnisskala angegeben und erlaubt eine 

kleinteiligere Diskriminierung plaquebedeckter Bereiche als die traditionellen 

klinischen Indizes. Da es sich um objektive Verfahren handelt, entfällt die aufwändige 

Kalibrierung von Untersuchern, es wird die reale Plaquemenge erfasst und die 
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Reproduzierbarkeit der Werte ist hoch (Carter et al., 2004; Quirynen et al., 1991; 

Rikvold et al., 2023; Smith et al., 2001).

Ein erster Versuch, computergestützte, planimetrische Verfahren zur quantitativen 

Erhebung dentalen Biofilms zu entwickeln, wurde von Söder et al., 1993 

unternommen: Sie entwickelten den „Plaque Percent Index“ (PPI). Zunächst wurden 

Fotos von den mit Erythrosin angefärbten Zähnen aufgenommen. Diese wurden dann 

digitalisiert und über ein „computerized image analysis system“ (CIAS) ausgewertet, 

indem plaquebedeckte und plaquefreie Bereiche nachgezeichnet und deren Farbpixel 

automatisch gezählt wurden. Der PPI wird durch die folgende Formel berechnet:

Formel 1: Berechnung des PPI

Als Standardisierung für die Anfertigung der Fotos wurden für die jeweiligen 

Zahnflächen bestimmte Winkel und Einstellungen des Fotoapparates festgelegt. Die 

Autoren hoben schon damals die starke Beeinflussung der Ergebnisse durch den 

Winkel der Aufnahme hervor.

Staudt et al. (2001) modifizierten den PPI, indem sie zunächst die zahnbegrenzten 

Bereiche manuell mit einer Maske überzogen und anschließend über Farbfilter die 

plaquefreien Areale ermittelten. Danach wurden diese Masken mit einer definierten 

Farbe gefüllt und die Pixelzahl zu der übrigen, von Plaque bedeckten Fläche und ihrer 

Pixelzahl in Verhältnis gesetzt. Außerdem wurde ein intraorales Kamerasystem mit 

CCD-Sensor (charge-coupled device bzw. ladungsgekoppeltes Bauteil), welcher über 

eine Schiene intraoral fixiert wurde, entwickelt, um die lingualen Zahnoberflächen mit 

höherer Reproduzierbarkeit aufzunehmen. Dies ermöglichte erstmals die Einbeziehung 

lingualer Zahnflächen in ein planimetrisches Verfahren.
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Um die Reproduzierbarkeit der Fotoaufnahmen zu erhöhen, wurden neben der 

erwähnten Festlegung von Aufnahmewinkeln und kamerafixierenden Schienen auch 

cephalometrische Kopfhalter verwendet (Smith et al., 2001). 

Mit der quantitativen lichtinduzierten Fluoreszenz (QLF) gab es ein neues Werkzeug 

der nicht-invasiven Diagnostik von Karies. Dabei wird die sichtbare Autofluoreszenz 

der Zahnhartsubstanzen ausgewertet. Da kariöse Läsionen aufgrund der 

Demineralisierung eine im Vergleich zu gesundem Schmelz oder Dentin geringere 

Autofluoreszenz aufweisen, kann so Karies detektiert werden. Plaque fluoresziert 

orange-rötlich. Es war daher naheliegend, dass Pretty et al., 2005 eine Pilotstudie 

durchführten, um die Verwendung der lichtinduzierten Fluoreszenz in der Planimetrie 

zu untersuchen. Besondere Aufmerksamkeit verdient diesem Verfahren die Tatsache, 

dass durch die Definition der Farbstufen auch Rückschlüsse auf die Plaquedicke 

möglich waren, während alle bis dahin bekannten bildbasierten Verfahren lediglich die 

zweidimensionale Ausbreitung erfassen konnten. Diese Methodik wurde in dem Sinne 

erweitert, dass diese Methodik auf Seitenzähne ausgedehnt wurde (Ganss et al., 2020). 

Andere Verfahren nutzten die Eigenfluoreszenz der Zähne aus, die die automatische 

Konturerkennung ermöglicht (Del Rey et al., 2023; Rikvold et al., 2023). Eine 

manuelle digitale Einzeichnung war so nicht mehr nötig. Die standardisierte 

Anfertigung der Fotos gestaltete sich gerade in den stark von Plaque betroffenen 

posterioren Seitenzähne jedoch weiterhin schwierig.

Die Etablierung von 3D-Intraloralscans im klinischen Alltag liefert ein neues Werkzeug 

in der optischen Erfassung der Zähne. Sie löst die starke Limitierung der fotografischen 

Aufnahme der posterioren Seitenzähne auf. Mit Hilfe des 3D-Intraloralscanners können 

die gesamte Zahnreihe und die angefärbte Plaque in relativ kurzer Zeit erfasst und alle 

Zahnbereiche gleichmäßig ausgeleuchtet und in einer dreidimensionalen Darstellung 

erfasst werden. Jung et al. (Jung et al., 2022) untersuchten anhand von 20 Probanden 

die Validität der Planimetrie auf Basis von 3D-Intraloralscans. Die Ramfjord-Zähne 

(16, 21, 24, 36, 41 und 44) wurden nach Anfärben der habituellen Plaquebedeckung 

(Zeitpunkt T1), nach 72-stündiger Mundhygieneabstinenz (Zeitpunkt T2) und 
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anschließendem Zähneputzen (Zeitpunkt T3) sowohl von einer intraoralen Kamera als 

auch einem 3D-Intraoralscanner vestibulär optisch erfasst. Der ermittelte prozentuale 

Anteil der plaquebedeckten Flächen (P%) ergab eine hohe Korrelation (r = 0,876; p < 

0,001) in der Bewertung der Zahnflächen. Die Erkennung der Plaque und auch 

kleinster Plaqueinseln auf Zahnoberflächen ist mit dem 3D-Intraloralscans somit in 

vergleichbarer Weise möglich wie die Verwendung von Fotografien. Wegen der 

geometrischen Verzeichnung der distalen und mesialen Anteile und der ungleichen 

Belichtung eignen sich 3D-Intraloralscans jedoch besser als intraorale Fotografien 

(Jung et al., 2022).

Verschiedene 3D-Intraoralscanner erzeugen 3D-Intraloralscans mit etwas 

unterschiedlicher Farbgebung. Inwieweit dies nachfolgend die planimetrische 

Erfassung der Plaque beeinflusst, wurde von Jung et al. (Jung et al., 2024) untersucht: 

Die Scanner Dexis IS 3800 W, Medit i700, Primescan und Trios 5 erfassten dabei 

dieselben Kiefer zum Zeitpunkt T1nach 72-stündiger Mundhygieneabstinenz und zum 

Zeitpunkt T2 nach üblicher Mundhygiene. Der Scanner Dexis IS 3800 W nahm dabei 

die Funktion einer Referenz ein. Ohne Anpassung des Schwellenwerts zur Erkennung 

der Plaque ergaben sich für alle 3D-Intraloralscanner niedrigere plaquebedeckte 

Flächen (P%) als die des Referenzmodells. Nach Anpassen des Schwellenwertes für 

jeden einzelnen 3D-Intraoralscanner ergaben sich ähnliche Werte zu dem 

Referenzmodell, auch wenn Primescan und Trios5 noch immer eine Trendenz zu 

geringeren plaquebedeckten Flächen (P%) aufwiesen (Jung et al., 2024).

Als gängige Färbemethode für Plaque wird in den gängigen Studien Mira-2-Ton (Hager 

& Werken GmbH & Co KG, Duisburg, Deutschland) verwendet. Es färbt die Plaque in 

einem rötlichen Ton an. Yoshiga et al. untersuchten 2024, inwiefern unterschiedliche 

Farbtöne die Erkennung der Plaque in der Planimetrie beeinflussen. Dabei wurden 

Kunststoffzähne mit wasserbasierter Tinte rot, blau und grün bemalt und mit einer 

Spiegelreflexkamera (EOS 60D; Canon, Tokio, Japan) und einem 3D-Intraloralscanner 

(TRIOS 3 Basic; 3 Shape, Kopenhagen, Dänemark) optisch erfasst. Zusätzlich wurde in 

einem klinischen Setting konventionell rötlich angefärbte Plaque am Patienten mit den 
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oben genannten Methoden aufgenommen. Es konnten keine signifikanten Unterschiede 

in der quantitativen Erfassung der unterschiedlichen Farben festgestellt werden. Die 

klinisch erprobte rötliche Anfärbung der Plaque ist somit gerechtfertigt. Jedoch 

erschien die Farbe in den Aufnahmen des 3D-Intraloralscanners leicht blasser und die 

Grenzen wegen der geringeren Auflösung der Aufnahmen relativ verwaschener 

(Yoshiga et al., 2024).

5.1.3 Diskussion der Methodik

Der Betrachtungswinkel und Zoom haben einen maßgeblichen Einfluss auf die 

berechnete Plaquemenge. Um denselben Kiefer zu zwei Zeitpunkten zu vergleichen, 

müssen diese vor Erstellung der 2D-Bilder standardisiert werden. 

Bislang wurde dies durch standardisiertes Zoomen im scannereigenen Programm und 

anschließender visueller Ausrichtung jedes Folgescans im Vergleich zum Ausgangsscan 

erreicht (Jung et al. 2022). Dieses Verfahren liefert zwar gut reproduzierbare Daten, 

birgt jedoch durch die subjektive Ausrichtung dennoch einen gewissen Grad an 

Ungenauigkeit. 

Ein wesentlicher Aspekt der vorliegenden Arbeit war es daher, das bislang verwendete 

Verfahren zu optimieren. 

 

Bei der vorliegenden Arbeit wurde vom 3D-Intraloralscanner ein dreidimensionales 

Objekt erzeugt, welches in MeshLab frei bewegt werden konnte. Indem die Kiefer der 

Zeitpunkte T0 und T1 genau ineinandergelegt wurden, konnten die Bilder für die Kiefer 

zum Zeitpunkt T0 und T1 synchron angefertigt werden. Somit entfiel die Variable der 

standardisierten Fotografie. Die Differenz der Ausrichtung der virtuellen Kamera vor 

Anfertigung der mit der Fotografie vergleichbaren Screenshots zum Zeitpunkt T0 und 

T1 stellte die geometrische Varianz im Scan- und Matchprozess dar. Die geometrische 

Varianz im Scanprozess ist sehr klein (Ting-Shu & Jian, 2015; Zhang et al., 2016). 

Somit war eine sehr hohe intraindividuelle Vergleichbarkeit gewährleistet. Die freie 

Bewegung im Raum ermöglichte außerdem, auch weiter distal stehende Zähne wie die 

zweiten Molaren in Beziehung zu der definierten Ebene zu betrachten. So gestaltete 
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sich gerade dort in vorangegangenen Studien die Anfertigung von Fotos mit meist 

orthogonaler Ausrichtung schwierig.

Zähne nehmen konvexe und konkave Formen an. Bei der zweidimensionalen 

Betrachtung einer dreidimensionalen konvexen Zahnfläche in der Zentralprojektion wie 

bei einem Foto nehmen die klinisch wichtigen distalen und mesialen Zahnanteile 

wegen der perspektivischen Verzeichnung unverhältnismäßig kleine Ausmaße an, da 

diese von der Betrachtungsperspektive weiter entfernt sind. Durch die Einstellung der 

Parallelprojektion („Toggle Orthographic Camera“) in MeshLab können wir die Zähne 

bzw. Zahnanteile verhältnistreu betrachten und somit später verhältnistreu 

planimetrisch auswerten.

Der Einfluss des Betrachtungswinkels in Bezug zur interindividuellen Vergleichbarkeit 

wurde durch die Definition der achsenbestimmenden Bezugspunkte minimiert. Da die 

Rotation über die y-Achse frei wählbar gewesen war, ergab sich eine etwas niedrigere 

interindividuelle Vergleichbarkeit.

Nach dem Überlagern der Kiefer in MeshLab und dem synchronen Anfertigen der 

Screenshots des Zeitpunkts T0 und T1 wurden die Zahnoberflächen in GIMP weiter 

bearbeitet. Da die Bilder der Zahnoberflächen zum Zeitpunkt T0 und T1 synchron 

ausgeschnitten worden waren, lagen zwei Bilder mit identischem Zahnumriss zur 

planimetrischen Auswertung vor. Dies gewährleistete nachfolgend der synchronen 

Anfertigung der Screenshots weiterhin die hohe intraindividuelle Vergleichbarkeit.

Das Ausschneiden der Zahnoberfläche bei etwaigen Artefakten, ungenügendem 

Scanprozess oder geometrischen Ungenauigkeiten bei der Überlagerung in MeshLab 

führte zwar zu Verlust von auszuwertender Zahnoberfläche. Da der Schnitt jedoch 

durch alle Ebenen ging, wurden nur Zahnoberflächen ausgewertet, welche zum 

Zeitpunkt T0 als auch T1 gut abgebildet worden waren.

Üblich war in den bisherigen Studien die separate Auswertung jedes einzelnen Zahnes 

und Zeitpunktes. In dieser Studie wurden die Variablen damit stark begrenzt.
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Computergestützte, automatisierte Verfahren zu Beurteilung der Plaquemenge sind 

anderen Methoden in Bezug auf Objektivität, Sensitivität und Reliabilität überlegen 

(Carter et al., 2004). Diese Feststellung bezieht sich auf die Quantifizierung der Plaque 

auf Basis von Fotos, welche digitalisiert und so weiter computergestützt mithilfe 

manueller Detektion der Plaqueareale ausgewertet wurden. Die Erhebung der Daten auf 

Basis von 3D-Intraoralscans kann als logische Konsequenz eines weiterführenden 

computergestützten Verfahrens angesehen werden. Der vollautomatisierten 

Plaquebestimmung auf Grundlage der 2D-Screenshots steht jedoch die weiterhin 

manuelle Einzeichnung zahnbegrenzter Areale in dieser Studie entgegen.

Die Plaquebedeckung wurde im Verhältnis zur gesamten Zahnoberfläche angegeben. Es 

wird somit keine Aussage zu Verteilung der Plaque innerhalb der Zahnoberfläche 

getroffen. 

Weiter berechnete die in dieser Studie ermittelte Plaquebedeckung ausschließlich die 

zweidimensionale Plaqueausdehnung auf der Zahnoberfläche. Es ist somit keine 

Beurteilung der Dicke bzw. der dreidimensionalen Struktur der Plaque möglich. Mira-

2-Ton färbt Plaque in zwei Farbstufen an. Ältere Plaque wird bläulicher, neuere Plaque 

rötlicher angefärbt. Zwar werden beide Farbstufen der angefärbten Plaque in der 

planimetrischen Auswertung erkannt, diese jedoch nicht differenziert.

Beide Faktoren, fehlende dreidimensionale Struktur und fehlende Beurteilung der 

Beschaffenheit der Plaque, führen dazu, dass keine Aussage über die Qualität der 

detektierten Plaque zu geben ist. So kann es sein, dass Probanden mit geringer 

Plaquebedeckung hohe Entzündungswerte aufweisen oder anders herum. Neben den 

rein planimetrischen sollten die mikrobiologischen Aspekte nicht vergessen werden.

Eine Studie, die Indizes, welche Entzündungen darstellen können, einbezieht, könnte 

hier weiter Aufschluss bieten.

Um die Anwendung des planimetrischen Verfahrens zu trainieren, stand ein 3D-

Intraoralscan aus einer vorangegangenen Studie zur Verfügung.

Zur Überprüfung der Reproduzierbarkeit wurde ein zufällig ausgewählter 3D-

Intraloralscan, der Teil der Studie war, herangezogen und abermals ausgewertet.
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Zur Bestimmung der Interrater-Reliabilität bewerteten Cicchetti, als auch Koo und Li  

den Intraklassenkorrelationskoeffizienten wie folgt (Cicchetti, 1994; Koo & Li, 2016):

Tabelle 3: Bewertung des Intraklassenkorrelationskoeffizienten nach Cicchetti (1994) und Koo & Li 
(2016)

Cicchetti (1994) Koo & Li (2016)

Schlecht < 0,4 < 0,5

Durchschnittlich 0,40 – 0,59 0,5 – 0,75

Gut 0,6 – 0,74 0,75 – 0,9

Sehr gut ≥ 0,75 ≥ 0,9

Mit einem ermittelten Intraklassenkorrelationskoeffizient von 0,999 [0,998;0,999) für 

T0 und 0,994 [0,989; 0,996] für T1 (p jeweils < 0,001) wurde eine sehr gute 

Urteilskonkordanz erreicht.

5.2 Mundhygieneinstruktionen

Das wissenschaftliche Verständnis der Ätiologie und Pathogenese der Karies und 

Parodontalerkrankungen haben große Fortschritte gemacht. Darauf aufbauend konnten 

individuelle und bevölkerungsbasierte Prophylaxemaßnahmen eingeführt werden. In 

Deutschland ist die Kariesprävalenz rückläufig, was zeigt, dass die 

Prophylaxemaßnahmen greifen (Cholmakow-Bodechtel et al., 2016).

Mundhygieneinstruktionen dienen dazu, die individuellen Mundhygienemaßnahmen zu 

verbessern und damit eine Plaquereduktion zu erreichen.

Welche Methode der Mundhygieneinstruktion die effektivste ist, ist nicht geklärt 

(Soldani et al., 2018). Jedoch verbessert sich die Putztechnik als auch -systematik nach 

Demonstration am Modell mit verbaler Erklärung oder mit Instruktionsvideos mehr als 

nach alleiniger schriftlicher Instruktion (Addy et al., 1999; Renton-Harper et al., 1999; 

Schlueter et al., 2010). 
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Inwieweit die Verbesserung im Mundhyieneverhalten nachhaltig ist, muss weiter 

diskutiert werden. Dabei sollte beachtet werden, dass der Erfolg der 

Mundhygieneinstruktion in Bezug zur Plaquereduktion vom Alter abhängt. So zeigen 

Erwachsene im Gegensatz zu neunjährigen Kindern nach sechs Monaten in einem 

individuellen Prophylaxeprogramm deutliche Verbesserungen des Plaquestatus. 

Langfristige, über sechs Monate hinausgehende Effekte von singulären 

Mundhygieneinstruktionen sind nicht belegt (Watt & Marinho, 2005; Zimmer et al., 

2001).

Werden die Mundhygieneinstruktionen über mehrere Jahre im Zusammenhang mit der 

zahnärztlichen Prophylaxe durchgeführt, werden niedrigere Plaquewerte (nach 

O‘Leary) erreicht als nach einmaliger Mundhygieneinstruktion (Furusawa et al., 2011).

Es sind aber auch indirekte Lernmethoden denkbar, beispielsweise das implizite oder 

explizite Übertragen von Wissen und Verhalten von Personen, die an 

Präventionsprogrammen teilnehmen, an nahestehende Personen. So nehmen Kinder 

häufig an Aufklärungsprogrammen in der Schule oder Erwachsene eines Haushaltes an 

Präventionsmaßnahmen in einer niedergelassenen Praxis teil. 

Die jeweils im Umfeld lebenden Personen könnten durch die Motivation und positiven 

Druck der instruierten Personen, durch Beobachtung neu erlernter Putztechniken oder 

durch neue Zahnpflegeprodukte auch ihr eigenes Verhalten ändern.

5.3 Inzidentelles Lernen

Lernen bedeutet Veränderung im Verhalten, Denken und Fühlen. Somit wird Lernen 

über eine Verhaltensänderung definiert (Lefrançois, 2015). Um eine 

Verhaltensänderung zu erreichen, braucht es eine Aneignung von Wissen und 

Fähigkeiten durch Erfahrungen. Durch Lernen verändert sich also auch das Können 

und Wissen. Der Lernende behält das Erlernte im expliziten oder impliziten 

Gedächtnis. 

Das explizite Gedächtnis beschreibt das bewusste Gedächtnis. Es besteht zumeist aus 

bildhaften Informationen und lässt sich in Worte fassen. Es ist verbalisierbar und somit 
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deklarativ. Das explizite Gedächtnis wird ferner in ein semantisches und episodisches 

Gedächtnis unterteilt.

Das implizite Gedächtnis beschreibt hingegen das unbewusste Gedächtnis. Es ist nicht 

verbalisierbar und nondeklarativ (Mazur, 2006).

Dabei beschreibt die Verhaltensänderung nicht nur veränderte Aktivitäten als solche, 

sondern auch das Potenzial zu veränderten Aktivitäten. So kann das Potenzial einer 

Verhaltensänderung nach Lernen vorliegen, sich aber keine Gelegenheit zur 

Verhaltensänderung zeigen. Des Weiteren kann sich auch die Disposition des 

Lernenden verändern. Mit der Disposition verändert sich die Neigung, bestimmte 

Aktivitäten auszuführen (Lefrançois, 2015).

Phase 1: Erfahrungsprozess 

Phase 2: Lernprozess 

Phase 3: Verhaltensänderung 

Schaubild 2: Ablauf des Prozesses des Lernens, eigene Darstellung in Anlehnung an (Lefrançois, 2015)

Analog zum Konzept des impliziten Gedächtnisses verhält sich das Konzept des 

impliziten Lernens. Auch wenn mit dem Lernen meist das aktive, explizite Lernen 

assoziiert wird, findet Lernen auch unbemerkt und unbewusst statt. Dies wird unter 

implizitem Lernen verstanden. Es kann auch als intuitiv beschrieben werden. Die 

darauffolgenden Verhaltensänderungen können folglich auch nicht begründet werden 

(Röhr-Sendlmeier, 2012). Dabei handelte es sich nicht um dichotome, sich 
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ausschließende Lernformen. Vielmehr stellen sie ein Kontinuum dar. Eine Form des 

impliziten Lernens ist die des inzidentellen Lernens.

Inzidentelles Lernen beschreibt das beiläufige Lernen bzw. Lernen „en passant“ 

(Reischmann, J., 1995). Das Lernen erfolgt dabei wie das implizite Lernen ohne 

Lernintention und -instruktion und zufällig. So wird bei jeder Tätigkeit implizites 

Wissen erworben, ohne dass es dem Subjekt bewusst ist.

Dabei geht das Konzept des inzidentellen Lernens in das des impliziten Lernens über. 

So haben beide Begriffe unterschiedliche theoretische Ursprünge, beschreiben jedoch 

den gleichen Sachverhalt (Hoh, 2003). Nach Reber ist das inzidentelle Lernen neben 

dem abstrakten, unbewussten Wissenszuwachs Charakter des impliziten Lernens 

(Reber, 1989). Betrachten wir das implizite Lernen vom Standpunkt des Gelernten aus, 

so kann eine Veränderung im Verhalten durch Erfahrungen und mit ihrer 

einhergehenden unbewussten Erkenntnis und Einsicht erfolgen (Hoffmann & Kintsch, 

1996). Der Modus des inzidentellen Lernens geht jedoch keinesfalls ausschließlich mit 

implizitem Wissen einher (Mazur, 2006).

Die meisten manuellen Fähigkeiten werden inzidentell gelernt. In diesem 

Zusammenhang wird auch von einem prozedualen Gedächtnis gesprochen. Wir sind zu 

Fähigkeiten in der Lage, ohne zu wissen, die Fähigkeiten je erworben zu haben. Dies ist 

insbesondere bei manuellen Kompetenzen wie zum Beispiel Gewohnheiten und 

Bewegungsabläufen wie dem Zähneputzen der Fall. Kennzeichen solcher erworbenen 

manuellen Fähigkeiten ist, dass diese schwer in Worte zu fassen, also nicht 

verbalisierbar und nicht explizit verfügbar sind. Es ist somit Teil des impliziten 

Gedächtnisses (Mazur, 2006; Spitzer, 2003).

Das siebte Semester mit dem Kursus der Zahnerhaltungskunde I stellt das erste 

Semester mit Patientinnen- und Patientenkontakt dar. Dem entsprechend kann von einer 

gewissen emotionalen Erregtheit ausgegangen werden. Untersuchungen zeigten, dass 

Emotionalität die Lernerfolge verbessert. So wurden in einer Studie Gruppen Texte mit 

gleichem Inhalt, aber unterschiedlicher Emotionialisierung vorgelesen. Die Gruppe mit 

höherer Emotionalisierung erinnerte den Inhalt signifikant besser. 
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Um dem Mechanismus der Emotionalität weiter auf den Grund zu gehen, wurden dabei 

auch β-Blocker und Placebo angewandt. Während die Gruppe mit Placebo in 

Verbindung mit Emotionen weiter höhere Lerneffekte aufwiesen, war die Gruppe mit β-

Blocker und emotionalisierendem Text mit den Gruppen, welche neutrale Texte 

vorgelesen bekamen, vergleichbar (Cahill et al., 1994; vgl. Spitzer, 2003). Es ist daher 

nicht verwunderlich, dass Spitzer, 2003 konstatierte: „Oder betrachten wir das 

Medizinstudium: Junge Menschen kommen an die Universität und wollen Heilen 

lernen. Aber man ärgert sie zunächst für […] Jahre damit, dass sie Inhalte lernen 

müssen, die mit Heilen nur sehr indirekt (oder gar nicht) in Verbindung stehen. Damit 

nimmt man den Studenten systematisch genau das, was sie zum Lernen dringend 

brauchen: die emotionale Komponente der zu lernenden Daten und Fakten, das innere 

Beteiligt-Sein, die Spannung des Dabei-Seins.“

Zu vermuten ist, dass der Faktor des Emotionalen das inzidentelle Lernen in diesem 

Kursus der Zahnerhaltungskunde I fördert und die Studenten angeregt werden, ihr 

Mundhygieneverhalten zu verändern.

Weiter ist festzuhalten, dass auch Interesse und Motivation, sowohl die intrinsische als 

auch extrinsische (Krapp & Prenzel, 1992), Angst und Stress (Spitzer, 2003) im 

wechselseitigen Einfluss auf Emotionalität, das Lernen im Allgemeinen und 

inzidentellen Lernen im Speziellen stehen.

Der empirische Nachweis des inzidentellen Lernens gestaltet sich nach wie vor 

schwierig. So können Anteile expliziten, den Lernerfolg des inzidentellen Lernens 

beeinflussende Anteile nicht ausgeschlossen werden. Kaum ein Experiment hat 

inzidentelles Lernen daher je eindeutig nachweisen können (Buchner, 1993).

Inwieweit andere, die Mundhygiene verbessernde, explizite Lernprozesse die 

Ergebnisse dieser Studie beeinflusst haben, ist daher unklar.

5.4 Diskussion der Studienergebnisse

Die Studierenden zeigten zu Beginn des Kurses der Zahnerhaltungskunde I 

unterschiedliche Plaquewerte. Während die Zahnoberflächen eines Studierenden über 
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ein Viertel Plaque aufwiesen, waren bei anderen Studierenden niedrige Plaquewerte 

von deutlich unter zehn Prozent zu beobachten. Das untersuchte Kollektiv zeigte somit 

zu T0 ein heterogenes Bild in Bezug auf Plaquewerte.

Stellt man die Plaquewerte der Probanden, die immerhin Studierende der Zahnmedizin 

waren, einer Studie entgegen, bei der die Probanden aus Studierenden aller 

Studienfächer rekrutiert wurden, stellt man fest, dass die Höhe der Plaquewerte sich 

ähnlich verhalten (Jung et al., 2022). Auch wenn der Kursus der Zahnerhaltungskunde I 

das erste klinische Semester mit intensiver Auseinandersetzung mit 

Mundhygieneinstruktionen darstellt, hätte man bei Studierenden der Zahnheilkunde 

eine höhere Sensibilität für die eigene Mundhygiene erwarten können.

Auch das Plaqueverteilungsmuster zeigte sich typisch. Die Molaren des Oberkiefers 

waren vestibulär zum Zeitpunkt T0 stark von Plaquebedeckung betroffen, Prämolaren 

und Frontzähne weniger. Es zeigte sich die Zunahme der Plaquebedeckung nach 

posterior. Die Oralflächen des Oberkiefers waren hingegen relativ gleichmäßig von 

Plaque betroffen. Im Unterkiefer zeigt sich das Plaqueverteilungsmuster anders, hier 

waren eher die Oral- als die Vestibulärflächen betroffen. Eine Zunahme nach posterior 

fand nicht statt, wenn auch die Frontzähne geringere Plaquewerte aufwiesen.

Es zeigte sich, dass sich Plaque mit Regelmäßigkeit an bestimmten Stellen bildet. 

Das in der vorliegenden Studie aufgetretene Muster der Plaqueverteilung korreliert 

dabei mit den Ergebnissen weiterer Studien. So konnten auch Furuichi et al. (Furuichi 

et al., 1992) nach einer zweiwöchigen Beobachtung von zehn Probanden bei 

unterlassener Mundhygiene bei den Frontzähnen des Oberkiefers unter Anwendung des 

Plaqueindex nach Silness und Löe eine geringere Plaquebedeckung im Vergleich zu den 

Seitenzähne feststellen, wobei jedoch die palatinalen Flächen der Seitenzähne relativ 

gering betroffen waren. Im Unterkiefer waren die Frontzähne auch weniger von Plaque 

bedeckt als die Seitenzähne des Unterkiefers, der Unterschied fiel jedoch nicht so 

deutlich aus wie im Oberkiefer. Auch waren die Bukkalflächen im Unterkiefer 

insgesamt weniger von Plaque bedeckt als die oralen Flächen (Furuichi et al., 1992).
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Söder et al. fanden 2003 das oben aufgeführte Plaqueverteilungsmuster ebenfalls vor. 

Dreiundvierzig Probanden wurden einer professionellen Zahnreinigung unterzogen und 

führten danach ihre habituelle Mundhygiene für einen Monat fort. Anschließend wurde 

in einem planimetrischen Verfahren auf Grundlage von Fotos die prozentuale 

Plaquebedeckung der Probanden ermittelt. Die Frontzähne im Oberkiefer wiesen 

insgesamt eine geringere Plaquebedeckung auf, während die Oberkieferzähne 

vestibulär eine höhere Plaquebedeckung als palatinal und die Unterkiefer lingual eine 

höhere Plaquebedeckung als vestibulär zeigten (Söder et al., 2003).

Dieses typische Plaqueverteilungsmuster ist einerseits den oralen 

Selbstreinigungskräften insbesondere der Zunge, Wangen und Lippen geschuldet. Diese 

erreichen alle Oralflächen des Oberkiefers in etwa gleichmäßig, jedoch die 

Vestibulärflächen der Frontzähne mit nach anterior zunehmender Tendenz. Neben den 

Selbstreinigungskräften trägt andererseits auch das fest verankerte Zahnputzmuster 

jedes Individuums zum Plaqueverteilungsmuster bei. So zeigen Videoanalysen, dass die 

Oralflächen sowohl mit einer Hand- als auch elektrischen Zahnbürste deutlich weniger 

bis gar nicht geputzt werden (Ganss et al., 2018; Winterfeld et al., 2015).

Die sichtbaren Vestibulärflächen der Frontzähne waren auch bei den Studierenden der 

Zahnmedizin im siebten Semester am wenigsten betroffen. Die Vestibulärflächen der 

hinteren Zähne sowohl im Ober- als auch Unterkiefer wurden vernachlässigt. Dies ist in 

Anbetracht der Tatsache, dass den Studierenden bereits in den vorangegangenen 

Semestern der Zusammenhang zwischen dentalem Biofilm und Karies erläutert wurde, 

erstaunlich. Insgesamt zeigte sich eine große Spannweite der Plaquewerte, ein 

typisches Plaquemuster und eine ähnlich hohe Plaquebedeckung wie bei Studierenden 

von Fächern ohne Bezug zu Medizin oder Zahnmedizin.

Orale Gesundheit weist wie die allgemeine Gesundheit eine hohe Korrelation zu 

„soziologischen Schichtungsindikatoren“, insbesondere der Schulbildung, auf 

(Cholmakow-Bodechtel et al., 2016). Da die Menge der Plaque auch mit der 

Mundgesundheit korreliert, könnte man bei Studierenden, welche eine hohe 

Schulbildung mitbringen, von einer guten Mundhygiene ausgehen. Jedoch zeigen die 
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Molaren bukkal im Oberkiefer und die Molaren oral im Unterkiefer eine teilweise hohe 

Plaquebedeckung von bis zu fast einem Viertel, wie in den folgenden Abbildungen 

exemplarisch dargestellt:

Abbildung 29: Beispielbild des Zahnes 16 von vestibulär zum Zeitpunkt T1 mit einer Plaquebedeckung 
von 24,2 %, ähnlich dem arithmetischen Mittelwert der Gesamtgruppe für diesen Zahn.
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Abbildung 30:  Beispielbild des Zahnes 36 von oral zum Zeitpunkt T1 mit einer Plaquebedeckung von 
26,9 %, ähnlich dem arithmetischen Mittelwert der Gesamtgruppe für diesen Zahn. 
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Die Verbesserung vom Zeitpunkt T0 zum Zeitpunkt T1 erreichte insgesamt nur knapp 

Signifikanz. So verringerte sich der Plaquewert insgesamt von 14,5 ± 4,4 % zu T0 auf 

13,1 ± 3,7 % zu T1. Eine etwas stärkere, jedoch weiterhin marginale, Verbesserung 

zeigte sich im Terzil mit den höchsten Plaquewerten. Hier verringerte sich der 

Plaquewert von 19,1 ± 3,1 % zu T0 auf 15,1 ± 2,7 % zu T1. Dies lässt den Schluss zu, 

dass sich das Plaquelevel insgesamt nicht verändert hat. So bestand eine hohe 

Korrelation der Plaquewerte der Zeitpunkte T0 und T1 (siehe Abbildung 26).

Auch die Betrachtung der Plaquewerte nach Kiefer, Zahn und Fläche, also die 

Betrachtung des Plaqueverteilungsmusters, zeigt keine wesentlichen Veränderungen 

von T0 zu T1. Es ergeben sich für die Plaquewerte jeden Zahnes nach Fläche (siehe 

Tabelle 2) nur minimale, nicht signifikante Differenzen und fast immer signifikante 

Korrelationen.

Insgesamt zeigt sich, dass die Studierenden kein gutes Mundhygieneniveau aufwiesen, 

dieses trotz der genannten Erfahrungen in der Patientenbetreuung und dem 

Wissenszuwachs durch die begleitenden Vorlesungen zum Zeitpunkt T1 nicht 

signifikant verbesserten und sich auch das Muster der Plaqueverteilung nicht 

veränderte.

Die Studienergebnisse sind neben der begrenzten Probandenzahl durch folgende 

Gegebenheiten limitiert: So wurden die 3D-Intraloralscans mit dem Intraoralscanner 

CS 3600 der Firma Carestream Dental (Stuttgart, Deutschland) erfasst, dessen 

Markteinführung im Jahre 2016 war und somit zur Datenerhebung nicht mehr das 

neueste Modell war. Erschwerend kommt hinzu, dass die Studierenden im ersten 

zweiten klinischen Semester erst den Umgang mit dem 3D-Intraloralscanner erlernen 

mussten, auch wenn die Bedienung intuitiv und schnell erlernbar ist. Des Weiteren 

können die ungenügende Färbung der Plaque oder andere äußere Einflüsse wie 

zusätzliche Lichtquellen wie die der Behandlungsleuchten, welche unerwünschte 

Lichtreflexionen auf den Zähnen hervorrufen, die Aufnahme der Plaque und dessen 

planimetrische Auswertung erschwert haben.
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6 Schlussfolgerungen und Ausblick

Aufgrund der vorliegenden Daten ist festzustellen, dass die Studierenden von dem 

veränderten Vorgehen im Kurs für Zahnerhaltungskunde I nur wenig in Bezug auf ihre 

eigenen Mundhygiene profitiert haben. Inzidentelles Lernen hat somit nicht 

stattgefunden.

Dies kann mit dem tief verankerten Bewegungsmuster bei der Mundhygiene, das nur 

schwer veränderbar ist, zusammenhängen (Schlueter et al., 2010, 2013). Aber auch 

Faktoren auf psychologischer Ebene können eine Rolle spielen. So ist es denkbar, dass 

die Studierenden die Mundhygieneinstruktionen im professionellen studentischen 

Kontext nicht internalisierten. Sie beziehen die gemachten Erfahrungen somit nicht auf 

sich selbst und die eigene Mundhygiene. Dies ist insbesondere im Anbetracht dessen zu 

sehen, dass die meisten Studierenden geringe Karieserfahrung bzw. einen niedrigen 

DMF-T-Index aufweisen und somit möglicherweise keinen Handlungsbedarf zur 

Änderung der eigenen Mundhygiene sehen. Weiterhin besteht die Frage, ob das 

implizite Lernen bei einem hohen manuellen Komplexitätsgrad wie der Mundhygiene 

an seine Grenzen stößt und somit kein Lernen stattfindet. Ob und in welchem Umfang 

implizite Lernerfahrungen spätere explizite Lernprozesse beeinflussen, muss weiter 

untersucht werden.

Bezüglich der Methodik lässt sich festhalten, dass die methodische Umsetzung in der 

Plaquemessung in dieser Arbeit eine substanzielle Veränderung zu etablierten 

klinischen Indizes darstellt. So muss der Zahn nunmehr nicht gedanklich in bestimmte 

Bereiche geteilt werden, die zumal unterschiedlich groß sind. Auch bei geringer 

Plaquebedeckung konnte zuvor schnell der Maximalwert erreicht werden, was die 

Trennschärfe reduziert. Die Plaquebedeckung wird nunmehr nicht dichotom in 

ordinaler Skalierung bewertet. Vielmehr wird die Plaquebedeckung nun im Verhältnis 

zur Oberfläche des Zahnes, also in einer Verhältnisskala, angegeben.

Die Ergebnisse sind reproduzierbar und auf aufwendige Standardisierung bei der 

Fotografie kann verzichtet werden. Die zugrundeliegenden Screenshots der 

Zahnoberflächen zum Zeitpunkt T0 und T1 sind identisch in ihrer Ausrichtung und 
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Betrachtung, sodass sie eine hohe intraindividuelle Vergleichbarkeit ermöglichen. Die 

schwierige orthogonale fotografische Aufnahme der Molaren entfällt und Varianzen im 

Winkel und Abstand in den fotografischen Aufnahmen beeinflussen nicht das 

planimetrische Ergebnis.

Dennoch ist die in dieser Arbeit angewendete Methodik der Planimetrie nicht gänzlich 

automatisiert. So müssen weiterhin die zahnbegrenzten Anteile der Screenshots 

händisch eingezeichnet werden. Die in dieser Arbeit angewendete planimetrische 

Methode kann daher als semi-automatisch bezeichnet werden. Eine automatische 

Erkennung der zahnbegrenzenden Anteile wäre im Sinne der Effizienz und Objektivität 

wünschenswert und könnte eine Weiterentwicklung darstellen.

Die Ergebnisse geben weiterhin zwar Aufschluss über die zweidimensionale 

Ausbreitung der Plaque im Verhältnis zur nicht von Plaque bedeckten Zahnoberfläche. 

Jedoch wird weder über den Ort der Plaque noch über die Dicke und Qualität der 

Plaque eine Aussage getroffen. Auch lässt die verwendete Methodik eine 

Differenzierung der rötlicheren „frischen“ und bläulicheren „alten“ Plaque missen, die 

uns die Färbemethode mittels Mira-2-Ton ermöglichen würde. Diese Faktoren 

zusammen könnten uns Aufschluss einerseits über die Qualität der Plaque, andererseits 

dessen Zusammenhang zu Entzündungen des Zahnhalteapparates liefern. Auch hier 

wäre eine Weiterentwicklung wünschenswert.
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Zahnärztliche Prophylaxe kann die orale Mundgesundheit nachhaltig verbessern und 

hat sich im Paradigmenwechsel „Vorsorgen statt Versorgen“ in der zahnmedizinischen 

Versorgung Deutschlands etabliert.

Die Präventivzahnmedizinischen Sprechstunde in der Poliklinik für 

Zahnerhaltungskunde und Endodontologie an der Justus-Liebig-Universität in Gießen 

wurde substanziell mit aktiverer Einbeziehung der Studierenden umgestellt.

Ziel der vorliegenden Arbeit war es zu untersuchen, ob sich die Mundhygiene der 

Studierenden selber durch das neue Konzept verändert. Voraussetzung hierfür ist, dass 

ein inzidentelles Lernen stattfindet. Hierunter wird das beiläufige Lernen ohne 

Lernintention und -instruktion verstanden.

Dazu wurden die 3D-Intraoralscans, welche im Rahmen gegenseitiger Übungen im 

Kurs für Zahnerhaltungskunde I entstanden sind, einer retrospektiven Analyse 

unterzogen. Insgesamt standen jeweils 3D-Intraoralscans von 30 Studierenden in den 

Einführungswochen zu Beginn des Semesters, vor Durchführung des 

Präventionsprogramms an Patientinnen und Patienten (T0), und in den abschließenden 

Übungswochen zum Ende des Semesters, nach Durchführung des 

Präventionsprogramms an Patientinnen und Patienten (T1), zur Verfügung. Für die 

retrospektive Analyse wurde eine neue Methodik der Planimetrie entwickelt, die 

Auskunft über die Plaquebedeckung in einer Verhältniskala gab.

Vor Absolvierung des Kurses für Zahnerhaltungskunde I (T0) zeigte sich ein breites 

Spektrum von Plaquewerten bei den Studierenden, welches von 6,5% bis 25,4% 

reichte, sowie ein typisches Plaqueverteilungsmuster.

Obwohl sich das neue Konzept der Präventivzahnmedizinischen Sprechstunde mit der 

Visualisierung von Plaque im 3D-Bild deutlich von der herkömmlichen Art der 

Mundhygieneinstruktion unterscheidet, zeigte sich für die Studierenden im Sinne eines 

inzidentellen Lernens ein nur geringer Effekt. So hat sich nach Absolvierung des 

Kurses für Zahnerhaltungskunde I (T1) weder das Niveau der Mundhygiene insgesamt 

noch das Plaqueverteilungsmuster der Studierenden signifikant verändert: Die 
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prozentuale Plaquebedeckung sank von 14,5 ± 4,4 % zu T0 auf 13,1 ± 3,7 % zu T1. 

Das Terzil mit der höchsten Plaquebedeckung konnte eine marginale Verbesserung mit 

knapper Signifikanz erreichen. Eine substanzielle Änderung oder gar Verbesserung der 

Mundhygiene konnte bei den Studierenden insgesamt nicht beobachtet werden. Die 

Verteilung der Plaque blieb bestehen und bildete zu beiden Zeitpunkten das typische 

Plaqueverteilungsmuster ab.

Inzidentelles Lernen hat somit nicht stattgefunden. Dies kann in der fehlenden 

Internalisierung der Lerninhalte oder im Komplexitätsgrad der Mundhygiene begründet 

sein. Substanzielle Verbesserung brachte die Optimierung des planimetrischen 

Verfahrens, welche einen höheren Automatisierungsgrad und somit genauere Daten 

hervorbringt.
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Dental prophylaxis can sustainably improve oral health and has established itself in the 

paradigm shift to “prevention instead of treatment” in dental care in Germany.

The preventive dentistry consultation hours at the Polyclinic for Conservative Dentistry 

and Endodontology at the Justus Liebig University in Giessen have been substantially 

reorganized, with more active involvement of the students.

The aim of this study was to investigate whether the students' oral hygiene has changed 

because of the new concept. The prerequisite for this is that incidental learning takes 

place. This refers to incidental learning without learning intention and instruction.

For this purpose, 3D intraoral scans, which were created as part of reciprocal exercises 

in the course Dental Conservation I course were subjected to a retrospective analysis. 

In total, 3D intraoral scans were available from 30 students in the introductory weeks at 

the beginning of the semester, before the prevention programme was carried out on 

patients (T0), and in the final practice weeks at the end of the semester, after the 

prevention programme had been carried out on patients (T1). A new method of 

planimetry was developed for the retrospective analysis, which provided information 

on plaque coverage on a ratio scale.

Before completing the course Dental Conservation I (T0), the students showed a wide 

range of plaque values, ranging from 6.5% to 25.4%, and a typical plaque distribution 

pattern.

Although the new concept of preventive dental care with the visualisation of plaque in 

a 3D image differs significantly from the conventional type of oral hygiene instruction, 

the effect on the students in terms of incidental learning was only slight. Neither the 

overall level of oral hygiene nor the plaque distribution pattern of the students changed 

significantly after completing the course Dental Conservation I (T1): the percentage 

plaque coverage decreased from 14.5 ± 4.4 % at T0 to 13.1 ± 3.7 % at T1. The tercile 

with the highest plaque coverage achieved a marginal improvement with marginal 

significance. A substantial change or even improvement in oral hygiene could not be 
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observed in the students overall. The distribution of the plaque remained the same and 

reflected the typical plaque distribution pattern at both time points.

Incidental learning therefore did not take place. This may be due to the lack of 

internalization of the learning content or the degree of complexity of oral hygiene. 

Substantial improvement was achieved by optimizing the planimetric procedure, which 

resulted in a higher degree of automation and thus more accurate data.
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